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Mechanism Design with COSMOSMotion 

Preface 

This book is written to help you become familiar wi th COSMOSMotion, an add-on module of the 
SolidWorks software family, which supports model ing and analysis (or simulation) of mechanisms in a 
virtual (computer) environment. Capabilit ies in COSMOSMotion support you to use solid models created 
in SolidWorks to simulate and visualize mechanism mot ion and performance. Using COSMOSMotion 

early in the product development stage could prevent costly (and sometimes painful) redesign due to 
design defects found in the physical testing phase. Therefore, using COSMOSMotion for support of 
design decision making contributes to a more cost effective, reliable, and efficient product design process. 

This book covers the basic concepts and frequently used commands required to advance readers 

from a novice to an intermediate level in using COSMOSMotion. Basic concepts discussed in this book 

include model generation, such as assigning moving parts and creating joints and constraints; carrying out 

simulation and animation; and visualizing simulation results, such as graphs and spreadsheet data. These 

concepts are introduced using simple, yet realistic examples. 

Verifying the results obtained from the computer simulation is extremely important. One of the 
unique features of this book is the incorporation of theoretical discussions for kinematic and dynamic 
analyses in conjunction with the simulation results obtained using COSMOSMotion. The purpose of the 
theoretical discussions lies in solely supporting the verification of simulation results, rather than 
providing an in-depth discussion on the subject of mechanism design. COSMOSMotion is not foolproof. 
It requires a certain level of experience and expertise to master the software. Before arriving at that level, 
it is critical for you to verify the simulation results whenever possible. Verifying the simulation results 
will increase your confidence in using the software and prevent you from being fooled (hopefully, only 
occasionally) by any erroneous simulations produced by the software. 

Example files have been prepared for you to go through the lessons, including SolidWorks parts and 
assemblies, as well as completed COSMOSMotion models . You may want to start each lesson by 
reviewing the introduction and model sections and opening the assembly in COSMOSMotion to see the 
motion simulation, in hope of gaining more understanding about the example problems. In addition, Excel 

spreadsheets that support the theoretical verifications of selected examples are also available. You may 
download all model files and Excel spreadsheets from the w e b site of Schroff Development Corporation 

at: 

ht tp:/ /www.schroff .com/resources 

This book is wri t ten following a project-based learning approach and is intentionally kept simple to 

help you learn COSMOSMotion. Therefore, this book m a y not contain every single detail about 

COSMOSMotion. For a complete reference of COSMOSMotion, you may use on-line help in 

COSMOSMotion, or visit the web site of SolidWorks Corporation at: 

ht tp: / /www.sol idworks.com/ 

This book should serve self-learners well . If such describes you, you are expected to have basic 
Physics and Mathematics background, preferably a Bache lor ' s degree in science or engineering. In 
addition, this book assumes that you are familiar with the basic concept and operation of SolidWorks part 
and assembly modes . A self-learner should be able to complete all lessons in this book in about fifty 
hours. An investment of fifty hours should advance you from a novice to an intermediate level user. 

This book also serves class instructions well . The book will most likely be used as a supplemental 

textbook for courses like Mechanism Design, Rigid Body Dynamics, Computer-Aided Design, or 

http://www.schroff.com/resources
http://www.solidworks.com/
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Computer-Aided Engineering. This book should cover four to six weeks of class instruction, depending 
on h o w the courses are taught and the technical background of the students. Some of the exercise 
problems given at the end of the lessons m a y require significant effort for students to complete. The 
author strongly encourages instructors and/or teaching assistants to go through those exercises before 
assigning them to students. 

K H C 

Norman, Oklahoma 

M a y 15 ,2008 

Copyright 2008 by Kuang-Hua Chang. All rights reserved. This document m a y not be copied, 
photocopied, reproduced, transmitted, or translated in any form or for any purpose without the express 
written consent of the publisher Schroff Development Corporation. 
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The purpose of this lesson is to provide you with a brief overview on COSMOSMotion. 

COSMOSMotion is a virtual prototyping tool that supports mechanism analysis and design. Instead of 
building and testing physical prototypes of the mechanism, you m a y use COSMOSMotion to evaluate and 
refine the mechanism before finalizing the design and entering the functional prototyping stage. 
COSMOSMotion will help you analyze and eventually design better engineering products. More 
specifically, the software enables you to size motors and actuators, determine power consumption, layout 
l inkages, develop cams, understand gear drives, size springs and dampers, and determine h o w contacting 
parts behave, which would usually require tests of physical prototypes. With such information, you will 
gain insight on h o w the mechanism works and why i t behaves in certain ways . You will be able to modify 
the design and often achieve better design alternatives using the more convenient and less expensive 
virtual prototypes. In the long run, using virtual prototyping tools, such as COSMOSMotion, will help you 
become a more experienced and competent design engineer. 

In this lesson, we will start with a brief introduction to COSMOSMotion and the various types of 
physical problems that COSMOSMotion is capable of solving. We will then discuss capabilities offered 
by COSMOSMotion for creating motion models , conducting motion analyses, and v iewing motion 
analysis results. In the final section, we will ment ion examples employed in this book and topics to learn 
from these examples. 

No te that materials presented in this lesson will be kept brief. More details on various aspects of 

mechanism design and analysis using COSMOSMotion will be given in later lessons. 

1.2 W h a t is COSMOSMotion? 

COSMOSMotion is a computer software tool that supports engineers to analyze and design 

mechanisms. COSMOSMotion is a module of the SolidWorks product family developed by SolidWorks 

Corporation. This software supports users to create virtual mechanisms that answer general questions in 

product design as described next. An internal combust ion engine shown in Figures 1-1 and 1-2 will be 

used to illustrate some typical questions. 

1. Will the components of the mechanism collide in operation? For example, will the connecting rod 

collide with the inner surface of the piston or the inner surface of the engine case during operation? 

2. Will the components in the mechanism you design m o v e according to your intent? For example, will 

the piston stay entirely in the piston sleeve? Will the system lock up when the firing force aligns 

vertically with the connecting rod? 



3. H o w much torque or force does i t take to drive the mechanism? For example, what will be the 
min imum firing load to m o v e the piston? Note that in this case, proper friction forces must be added 
to simulate the resistance of the mechanism before a realistic firing force can be calculated. 

4. H o w fast will the components move; e.g., the longitudinal mot ion of the piston? 

5. What is the reaction force or torque generated at a connection (also called joint or constraint) 

between components (or bodies) during mot ion? For example, what is the reaction force at the jo in t 
between the connecting rod and the piston pin? This reaction force is critical since the structural 
integrity of the piston pin and the connecting rod mus t be ensured; i.e., they must be strong and 
durable enough to sustain the load in operation. 

The capabilities available in COSMOSMotion also help you search for better design alternatives. A 
better design alternative is very much problem dependent. It is critical that a design problem be clearly 
defined by the designer up front before searching for better design alternatives. For the engine example, a 
better design alternative can be a design that reveals: 

1. A smaller reaction force applied to the connecting rod, and 

2. No collisions or interference between components . 

In order to vary component sizes for exploring better design alternatives, the parts and assembly 
must be adequately parameterized to capture design intents. At the parts level, design parameterization 
implies creating solid features and relating dimensions properly. At the assembly level, design 
parameterization involves defining assembly mates and relating dimensions across parts. When a solid 
model is fully parameterized, a change in dimension value can be propagated to all parts affected 
automatically. Parts affected must be rebuilt successfully, and at the same t ime, they will have to maintain 
proper posit ion and orientation wi th respect to one another without violating any assembly mates or 
revealing part penetration or excessive gaps. For example, in this engine example, a change in the bore 



diameter of the engine case will alter not only the geometry of the case itself, but all other parts affected, 

such as the piston, piston sleeve, and even the crankshaft, as illustrated in Figure 1-3. Moreover , they all 

have to be rebuilt properly and the entire assembly must stay intact through assembly mates. 

1.3 Mechanism Design and Mot ion Analysis 

A mechanism is a mechanical device that transfers mot ion and/or force from a source to an output. It 
can be an abstraction (simplified model ) of a mechanical system. A linkage consists of links (or bodies), 
which are connected by joints (or connections), such as a revolute joint , to form open or closed chains (or 
loops, see Figure 1-4). Such kinematic chains, with at least one link fixed, become mechanisms. In this 
book, all links are assumed rigid. In general, a mechanism can be represented by its corresponding 
schematic drawing for analysis purpose. For example, a slider-crank mechanism represents the engine 
motion, as shown in Figure 1-5, which is a closed loop mechanism. 



In general, there are two types of mot ion problems that you will have to solve in order to answer 
questions regarding mechanism analysis and design: kinematic and dynamic. 

Kinemat ics is the study of mot ion wi thout regard for the forces that cause the motion. A kinematic 

mechanism mus t be driven by a servomotor (or mot ion driver) so that the position, velocity, and 

acceleration of each link of the mechanism can be analyzed at any given t ime. Typically, a kinematic 

analysis must be conducted before dynamic behavior of the mechanism can be simulated properly. 

Dynamic analysis is the study of mot ion in response to externally applied loads. The dynamic 

behavior of a mechanism is governed by N e w t o n ' s laws of motion. The simplest dynamic problem is the 

particle dynamics introduced in Sophomore Dynamics—for example, a spr ing-mass-damper system 

shown in Figure 1-6. In this case, mot ion of the mass is governed by the following equation derived from 

N e w t o n ' s second law, 

(1.1) 

where (•) appearing on top of the physical quantities represents t ime derivative of the quantities, m is the 
total mass of the block, k is the spring constant, and c is the damping coefficient. 

For a rigid body, mass properties 
(such as the total mass , center of mass , 
moment of inertia, etc.) are taken into 
account for dynamic analysis. For 
example, mot ion of a pendulum 
shown in Figure 1-7 is governed by 
the following equation of motion, 

YdM = -mgl s i n 0 = 10 = m£20 (1.2) 

where M is the external momen t (or 

torque), / is the polar momen t of 

inertia of the pendulum, m is the 

pendulum mass , g is the gravitational 

acceleration, and 6 is the angular 

acceleration of the pendulum. 

Dynamic analysis of a rigid body system, such as the single piston engine shown in Figure 1-3, is a 
lot more complicated than the single body problems. Usually, a system of differential and algebraic 
equations governs the mot ion and the dynamic behavior of the system. N e w t o n ' s law must be obeyed by 
every single body in the system at all t ime. The motion of the system will be determined by the loads 
acting on the bodies or jo in t axes (e.g., a torque driving the system). Reaction loads at the joint 
connections hold the bodies together. 

Note that in COSMOSMotion, you may create a kinematic analysis model ; e.g., using a mot ion 
driver to drive the mechanism; and then carry out dynamic analyses. In dynamic analysis, position, 
velocity, and acceleration results are identical to those of kinematic analysis. However , the inertia of the 
bodies will be taken into account for analysis; therefore, reaction forces will be calculated between 
bodies. 



1.4 COSMOSMotion Capabilit ies Ground Parts 

The overall process of using 
COSMOSMotion for analyzing a mechanism 
consists of three main steps: model generation, 
analysis (or simulation), and result visualization 
(or post-processing), as illustrated in Figure 1-8. 
Key entities that constitute a mot ion model 
include ground parts that are always fixed, 
moving parts that are movable , joints and 
constraints that connect and restrict relative 
mot ion be tween parts, servo motors (or mot ion 
drivers) that drive the mechanism for kinematic 
analysis, external loads (force and torque), and 
the initial conditions of the mechanism. More 
details about these entities will be discussed later 
in this lesson. 

The analysis or simulation capabilities in COSMOSMotion employ simulation engine, 
ADAMS/Solver, which solves the equations of mot ion for your mechanism. ADAMS/Solver calculates the 
position, velocity, acceleration, and reaction forces acting on each moving part in the mechanism. Typical 
simulation problems, including static (equilibrium configuration) and motion (kinematic and dynamic) , 
are supported. M o r e details about the analysis capabilities in COSMOSMotion will be discussed later in 
this lesson. 

The analysis results can be visualized in various forms. Y o u m a y animate motion of the mechanism, 
or generate graphs for more specific information, such as the reaction force of a jo int in t ime domain. Y o u 
may also query results at specific locations for a given t ime. Furthermore, you may ask for a report on 
results that you specified, such as the acceleration of a moving part in the t ime domain. Y o u may also 
convert the mot ion animation to an A V I for faster v iewing and file portability. In addition to AVI , you 
can export animations to V R M L format for distribution on the Internet. You can then use Cosmo Player, 

a plug-in to your W e b browser, to v iew V R M L files. To download Cosmo Player for Windows, go to 
http://ovrt.nist .gov/cosmo/. 

Operation Mode 

COSMOSMotion is embedded in SolidWorks. It is indeed an add-on module of SolidWorks, and 
transition from SolidWorks to COSMOSMotion is seamless. All the solid models , materials , assembly 
mates , etc. defined in SolidWorks are automatically carried over into COSMOSMotion. COSMOSMotion 

can be accessed through menus and windows inside SolidWorks. The same assembly created in 
SolidWorks can be directly employed for creating motion models in COSMOSMotion. In addition, part 
geometry is essential for mass property computat ions in mot ion analysis. In COSMOSMotion, all mass 
properties calculated in SolidWorks are ready for use. In addition, the detailed part geometry supports 
interference checking for the mechanism during mot ion simulation in COSMOSMotion. 

User Interfaces 

User interface of the COSMOSMotion is identical to that of SolidWorks, as shown in Figure 1-9. 

SolidWorks users should find it is straightforward to maneuver in COSMOSMotion. 

http://ovrt.nist.gov/cosmo/


As shown in Figure 1-9, the user interface window of COSMOSMotion 

consists of pul l -down menus , shortcut buttons, the browser, the graphics 

screen, the message window, etc. When COSMOSMotion is active, an extra 

tab $ (the Motion button) is available on top of the browser. This Motion 

button will allow you to access COSMOSMotion. 

The graphics screen displays the motion model with which you are 
working. The global coordinate system at the lower left corner of the 
graphics screen is fixed and serves as the reference for all the physical 
parameters defined in the motion model . The pul l -down menus and the 
shortcut buttons at the top of the screen provide typical SolidWorks 

functions. The assembly shortcut buttons allow you to assemble your 
SolidWorks model . The COSMOSMotion shortcut buttons on top of the 
graphics screen shown in Figure 1-9 provide all the functions required to 
create and modify the motion models , create and run analyses, and visualize 
results. 

As you m o v e the mouse over a button, a brief description about the 

functionality of the button, such as the Fast Reverse button shown in Figure 

1-9, will appear. 



When you choose a menu option, the Message window, at the lower left corner shown in Figure 1-9, 

shows a brief description about the option. In addition to these buttons, a COSMOSMotion pul l -down 

menu also provides similar options, as shown in Figure 1-10. 

W h e n you click the Motion button, the browser will provide you with a graphical, hierarchical v iew 

of mot ion model and allow you to access all COSMOSMotion functionalities through a combinat ion of 

drag-and-drop and right-click activated menus . 

For example, you may drag 
and drop connectingrod_asm-l 

under the Assembly Components, 

as shown in Figure 1-11 to 
Moving Parts under the Parts 

branch to define it as a moving 
part. Y o u m a y also right click an 
entity and choose to define or edit 
its property. For example, you 
may right click the Springs node 
under Forces branch in Figure 1-
12, and choose Add Translational 

Spring to add a spring. 

Switching back and forth between COSMOSMotion and SolidWorks assembly m o d e is 

straightforward. All you have to do is to click the Motion J? or Assembly buttons ^ (on top of the 

browser) when needed. When you click the Motion button <f? to enter COSMOSMotion, a different set of 

entities will be listed in the browser. In addition, an additional toolbar is added to SolidWorks, located at 

the top of the graphics screen, as depicted in Figure 1-13. They are the COSMOSMotion shortcut buttons 

shown in Figure 1-9. This toolbar provides settings, simulation and post processing features. Especially, 

the Play Simulation button is handy when you finish running a simulation and are ready to animate 
the motion. Click some of the buttons and try to get familiar with their functions. The shortcut buttons in 
COSMOSMotion and their functions are also summarized in Table 1-1 with a few more details. 



tabbed dialog box and a wizard that leads you through the process of convert ing an assembly model into a 
mot ion model , performing motion simulations, and viewing simulation results. 



To use the IntelliMotion Builder, click the 

IntelliMotion Builder but ton or right-click the 

Motion Model node (the root entity of the mot ion 

model) from the browser, and then select 

IntelliMotion Builder (see Figure 1-14). The first 

tab is Units, which brings up the Units page. 

At the lower-left corner of each page in the 

IntelliMotion Builder are the Back and Next 

buttons, which help you m o v e sequentially 

through the mot ion mode l creation, simulation, 

and animation process. Y o u may also click a tab 

on top to j u m p to that page directly, for example 

Parts, to define ground and moving parts. For a 

new COSMOSMotion user, the IntelliMotion 

Builder is very helpful in terms of leading you 

through the steps of creating simulations models , 

running simulations, and visualizing the 

simulation results. For a more experienced user, 

the drag-and-drop and right-click activated menus 

may be more convenient. 

Table 1-2 gives a brief explanation of each tab available in the IntelliMotion Builder. 

Defining COSMOSMotion Entities 

The basic entities of a val id COSMOSMotion s imulation model consist of ground parts, moving 

parts, constraints (including joints) , initial conditions, and forces and/or drivers. Each of the basic entities 

will be briefly discussed next. More details can be found in later lessons. 



Ground Parts (or Ground Body) 

A ground part, or a ground body, represents a fixed reference in space. The first component brought 

into the assembly is usually stationary; therefore, often becoming a ground part. You will have to identify 

moving and non-moving parts in your assembly, and assign the non-moving parts as ground parts using 

either the IntelliMotion Builder or the drag-and-drop in the browser. 

Moving Parts (or Bodies) 

A moving part or body is an entity represents a single rigid component (or link) that moves relatively 

to other parts (or bodies) . A moving part m a y consist of a single SolidWorks part or an assembly 

composed of multiple parts. W h e n an assembly is assigned as a moving part, none of its composing parts 

is al lowed to move relative to one another within the assembly. A moving part has six degrees of 

freedom, three translational and three rotational, while a ground part has none. That is, a rigid body can 

translate and rotate along the Y-, and Z-axes of a coordinate system. Rotat ion of a rigid body is 

measured by referring the orientation of its local coordinate system to the global coordinate system, which 

is shown at the lower left corner on the graphics screen. In COSMOSMotion, the local coordinate system 

is assigned automatically, usually, at the mass center of the part. Mass properties, including total mass , 

inertia, etc., are calculated using part geometry and material properties referring to the local coordinate 

system. A moving part has a symbol (see Figure l -16a) attached, usually located at its mass center, as 

shown in Figure 1-15. 

Constraints 

A constraint (or connection) in COSMOSMotion can be a joint , contact, or coupler that connects two 

parts and constrains the relative mot ion between them. Typical joints include a revolute, cylindrical, 

spherical, etc. Each independent movement permit ted by a constraint is a free degree of freedom (dof). 

The degrees of freedom that a constraint allows can be translational or rotational along the three 

perpendicular axes. The free dof is revealed by the symbol of the constraint. For example, the symbol of 

cylindrical jo ints , such as those defined in the engine example shown in Figure 1-15, show two concentric 

cylinders implying two free d o f s, a translational and a rotational, both are along the c o m m o n axis, as 

illustrated in Figure l -16b . Also, a revolute joint , for example the one between the propeller and the case 

shown in Figure 1-15, allows only one rotational dof, as depicted in a hinge symbol shown in Figure 1-

16c. Understanding the jo in t symbols will enable you to read existing mot ion models . Also, a jo in t 

produces equal and opposite reactions (forces and/or torques) on the bodies connected due to N e w t o n ' s 

3 r d Law. More about jo ints will be discussed in later lessons and for a list of commonly employed joints , 

please refer to Appendix A. 

COSMOSMotion automatically converts assembly mates to joints . For example, a concentric mate 

together with a coincident mate will be converted to a revolute joint . Sometimes, COSMOSMotion will 

simply carry over the assembly mates to mot ion if there is no adequate jo in t to convert to , following the 

mapped mates established internally. For a list of common mapped mates , please refer to Appendix A. 

You may either stay wi th the jo in t set converted by COSMOSMotion or delete some of them to create 

your own. However , i t is strongly recommended that you stay with the converted jo in t set before 

complet ing all the examples provided in this book. In all the examples presented in this book, mapped 

joints or mates are employed without any modification. 

Note that instead of completely fixing all the movements , certain d o f s (translational and/or 

rotational) are left to allow designated movement . For example, a mot ion driver is defined at the rotation 

dof of the revolute jo in t in the engine example, as shown in Figure 1-15. This mot ion driver will rotate the 



propeller at a prescribed angular velocity. In addition to prescribed velocity, you m a y use the mot ion 

driver to drive the dof at a prescribed displacement or acceleration, both translation and rotational. 

In addition to joints , COSMOSMotion provides contact and coupling constraints. The contact 

constraints help to simulate physical problems more realistically. COSMOSMotion supports four types of 

contact, point-curve, curve-curve, intermittent curve-curve, and 3D contact. Only the first two types of 

contact impose degree-of-freedom restrictions on the connected parts and are true constraints. The 3D 

contact is employed most frequently, which applies a force to separate the parts when they are in contact 



and prevent them from penetrating each other. The 3D contact constraint will become active as soon as 

the parts are touching. 

Joint couplers al low the mot ion of a revolute, cylindrical, or translational jo in t to be coupled to the 

mot ion of another revolute, cylindrical or translational joint . The two coupled jo ints m a y be of the same 

or different types. For example, a revolute jo in t m a y be coupled to a translational joint . The coupled 

mot ion m a y also be of the same or different type. For example, the rotary mot ion of a revolute jo in t may 

be coupled to the rotary mot ion of a cylindrical joint , or the translational mot ion of a translational jo in t 

m a y be coupled to the rotary mot ion of a cylindrical joint . A coupler removes one additional degree of 

freedom from the mot ion model . 

Degrees of Freedom 

As ment ioned earlier, an unconstrained body in space has six degrees of freedom; i.e., three 

translational and three rotational. When joints are added to connect bodies, constraints are imposed to 

restrict the relative mot ion between them. 

For example, the revolute jo int defined in the engine example restricts movement on five d o f s so 

that only one rotational mot ion is a l lowed between the propeller assembly and the engine case. Since the 

engine case is a ground body, the propeller assembly will rotate along the axis of the revolute joint , as 

illustrated in the symbol shown in Figure 1-16b. Therefore, there is only one degree of freedom left for 

the propeller assembly. For a given mot ion model , you can determine its number of degrees of freedom 

using the Gruebler ' s count. 

COSMOSMotion uses the following equation to calculate the Gruebler ' s count: 

D = 6M-N-0 (1.3) 

where D is the Gruebler ' s count representing the total degrees of freedom of the mechanism, M i s the 

number of bodies excluding the ground body, TV is the number of d o f s restricted by all jo ints , and O is the 

number of mot ion drivers defined in the system. 

In general, a val id mot ion model should have a Gruebler ' s count 0. However , in creating motion 

models , some joints remove redundant d o f s . For example, two hinges, mode led using two revolute joints , 

support a door. The second revolute jo in t adds five redundant d o f s. The Gruebler ' s count becomes: 

D = 6x1 -2x5 = -4 

For kinematic analysis, the Gruebler ' s count must be equal to or less than 0. The ADAMS/Solver 

recognizes and deactivates redundant constraints during analysis. For a kinematic analysis, if you create a 

model and try to animate it wi th a Gruebler ' s count greater than 0, the animation will not run and an error 

message will appear. 

The single-piston engine shown in Figure 1-15 consists of three bodies (excluding the ground body) , 

one revolute jo in t and three cylindrical joints . A revolute jo in t removes five degrees of freedom, and a 

cylindrical jo int removes four d o f s. In addition, a mot ion driver is added to the rotational dof of the 

revolute joint . Therefore, according to Eq. 1.3, the Gruebler ' s count for the engine example is 



If the Gruebler ' s count is less than zero, the solver will automatically remove redundancies . In this 

engine example, i f the two of the cylindrical jo ints ; be tween piston and the piston pin, and between the 

connecting rod and the crank shaft, are replaced by revolute joints , the Gruebler ' s count becomes 

D = 6x(4-l)-(3x5-1x4) - lxl = -2 

To get the Gruebler ' s count to zero, it is often possible to replace joints that remove a large number 

of constraints with joints that remove a smaller number of constraints and still restrict the mechanism 

mot ion in the same way. COSMOSMotion detects the redundancies and ignores redundant d o f s in all 

analyses, except for dynamic analysis. In dynamic analysis, the redundancies lead to an outcome with a 

possibility of incorrect reaction results, yet the mot ion is correct. For complete and accurate reaction 

forces, i t is critical that you eliminate redundancies from your mechanism. The challenge is to find the 

joints that will impose non-redundant constraints and still al low for the intended motion. Examples 

included in this book should give you some ideas in choosing proper jo ints . 

Forces 

Forces are used to operate a mechanism. Physically, forces are produced by motors , springs, 

dampers, gravity, tires, etc. A force entity in COSMOSMotion can be a force or torque. COSMOSMotion 

provides three types of forces: applied forces, flexible connectors, and gravity. 

Appl ied forces are forces that cause the mechanism to m o v e in certain ways . Appl ied forces are very 

general, but you mus t supply your own description of the force by specifying a constant force value or 

expression function, such as a harmonic function. The applied forces in COSMOSMotion include action-

only force or momen t (where force or m o m e n t is applied at a point on a single rigid body, and no reaction 

forces are calculated), action and reaction force and moment , and impact force. The force and momen t 

symbols in COSMOSMotion are shown in Figure 1-17 and 1-18, respectively. 

Figure 1-17 The Force (or Translational Figure 1-18 The Momen t (or Rotational 

Driver) Symbol Driver) Symbol 

Flexible connectors resist mot ion and are simpler and easier to use than applied forces because you 

only supply constant coefficients for the forces, for instance a spring constant. The flexible connectors 

include translational springs, torsional springs, translational dampers , torsional dampers , and bushings, 

which symbols are shown in Figure 1-19. 



A magni tude and a direction must be included for a force definition. You m a y select a predefined 

function, such as a harmonic function, to define the magni tude of the force or moment . For spring and 

damper, COSMOSMotion automatically makes the force magni tude proportional to the distance or 

velocity between two points , based on the spring constant and damping coefficient entered, respectively. 

The direction of a force (or moment ) can be defined by either along an axis defined by an edge or along 

the line between two points, where a spring or a damper is defined. 

Initial Conditions 

In motion simulations, initial conditions consist of initial configuration of the mechanism and initial 

velocity of one or more components of the mechanism. Mot ion simulation must start with a properly 

assembled solid model that determines an initial configuration of the mechanism, composed by posit ion 

and orientation of individual components . The initial configuration can be completely defined by 

assembly mates . However , one or more assembly mates will have to be suppressed, i f the assembly is 

fully constrained, to provide adequate movement . 

In COSMOSMotion, initial velocity is defined as part of definition of a moving part. The initial 

velocity can be translational or rotational along one of the three axes. 

Motion Drivers 

Motion drivers are used to impose a particular movement of a jo in t or part over t ime. A mot ion 

driver specifies position, velocity, or acceleration as a function of t ime, and can control either 

translational or rotational motion. The driver symbol is identical to those of Figures 1-17 and 1-18, for 

translational and rotational, respectively. When properly defined, mot ion drivers will account for the 

remaining dof s of the mechan ism that brings the Gruebler ' s count to zero or less. 

In the engine example shown in Figure 1-15, a mot ion driver is defined at the revolute jo int to rotate 

the propeller at a constant angular velocity. 

Motion Simulation 

The ADAMS/Solver employed by COSMOSMotion is 

capable of solving typical engineering problems, such as static 

(equilibrium configuration), kinematic , and dynamic, etc. 

Static analysis is used to find the rest position (equilibrium 

condition) of a mechanism, in which none of the bodies are 

moving . A simple example of the static analysis is illustrated in 

Figure 1-20, in which an equil ibrium posit ion of the block is to 

be determined according to its own mass m, the two spring 

constants ki and k2, and the gravity g. 

As discussed earlier, kinematics is the study of mot ion without regard for the forces that cause the 

motion. A mechanism can be driven by a motion driver (e.g., a servomotor) for a kinematic analysis, 

where the position, velocity, and acceleration of each link of the mechanism can be analyzed at any given 

t ime. Figure 1-21 shows a servomotor drives a mechanism at a constant angular velocity. 

Dynamic analysis is used to study the mechanism mot ion in response to loads, as illustrated in 

Figure 1-22. This is the mos t complicated and common, and usually a more t ime-consuming analysis. 



Viewing Results 

In COSMOSMotion, results of the mot ion analysis can be realized using animations, graphs, reports, 

and queries. Animat ions show the configuration of the mechanism in consecutive t ime frames. 

Animations will give you a global v iew on how the mechanism behaves , for example, the single-piston 

engine shown in Figure 1-23. You m a y also export the animation to A V I or V R M L for various purposes. 

In addition, you m a y choose a jo in t or a part to generate result graphs, for example, the posit ion vs. 

time of the piston in the engine example shown in Figure 1-24. These graphs give you a quantitative 

understanding on the characteristics of the mechanism. 

You may also query the results by moving the cursor closer to the curve and leave the cursor for a 

short period. The result data will appear next to the cursor. In addition, you m a y ask COSMOSMotion for 

a report that includes a complete set of results output in the form of textual data or a Microsoft® Excel 

spreadsheet. 

In addition to the capabilities discussed above, COSMOSMotion al lows you to check interference 

between bodies during mot ion (please see Lesson 5 for more details). Furthermore, the reaction forces 

calculated can be used to support structural analysis using, for example, COSMOSWorks. 



1.5 Motion Examples 

Numerous motion examples will be introduced in this book to illustrate the step-by-step details of 

model ing, simulation, and result visualization capabilities in COSMOSMotion. In addition, an application 

example will be introduced to illustrate the steps and principles of using COSMOSMotion for support of 

mechanism design. 

We will start wi th a simple ball- throwing example in Lesson 2. This example will give you a quick 

run-through on using COSMOSMotion. Lessons 3 through 7 focus on model ing and analysis of basic 

mechanisms and dynamic systems. In these lessons, you will learn various jo in t types, including revolute, 

planar, cylindrical, etc.; forces and connections, including springs, gears, cam-followers; drivers and 

forces; various analyses; and graphs and results. Lesson 8 is an application lesson, in which an assistive 

soccer ball kicking device that can be mounted on a wheelchair will be introduced to show you h o w to 

apply what you learn to real-world applications. All examples and main topics to be discussed in each 

lesson are summarized in the following table. 







2.1 Overview of the Lesson 

The purpose of this lesson is to provide you a quick run-through on using COSMOSMotion. This 

example simulates a ball thrown with an initial velocity at an elevation. D u e to gravity, the ball will travel 

following a parabolic trajectory and bounce back a few t imes when it hits the ground, as depicted in 

Figure 2 - 1 . In this lesson, you will learn h o w to create a mot ion model to simulate the ball motion, run a 

simulation, and animate the ball motion. Simulation results obtained from COSMOSMotion can be 

verified using particle dynamics theory that was learned in high school Physics. We will review the 

equations of motion, calculate the posit ion and velocity of the ball, and compare our calculations wi th 

results obtained from COSMOSMotion. Validating results obtained from computer simulations is 

extremely important. COSMOSMotion is not foolproof. It requires a certain level of experience and 

expertise to master the software. Before you arrive at that level, i t will be indispensable to verify the 

simulation results, whenever possible. Verifying the simulation results will increase your confidence in 

using the software and prevent you from being occasionally fooled by the erroneous simulations produced 

by the software. Note that very often the erroneous results are due to model ing errors. 

2.2 The Ball Throwing Example 

Physical Model 

The physical model of the ball example is very 

simple. The ball is made of Cast Alloy Steel with a 

radius of 10 in. The units system employed for this 

example is IPS (inch, pound, second). The 

gravitational acceleration is 386 in /sec 2 . Note that 

you m a y check or change the units system by 

choosing f rom the pul l -down m e n u 

Tools > Options 

and choose the Document Properties tab in the System Options - General dialog box, click the Units 

node, and then pick the units system you prefer, as shown in Figure 2-2. 

The ball and ground are assumed rigid. The ball will bounce back when it hits the ground. A 

coefficient of restitution C R = 0.75 is specified to determine the bounce velocity (therefore, the force) 

when the impact occurs. For this example, C R = V/Vt, where V% and are the velocities of the ball before 

and after the impact. That is, the bounce velocity will be 7 5 % of the incoming velocity, and certainly, in 

the opposite direction. Note that in order for COSMOSMotion to capture the momen t when the ball hits 

the ground, we will define a 3D contact constraint be tween the ball and the ground, and use the true 

geometry of the parts for a finer interference calculation during the simulation. 



SolidWorks Parts and Assembly 

For this lesson, the parts and assembly 

have been created for you in SolidWorks. 

There are four files created, ball.SLDPRT, 

ground. SLDPRT, Lesson2. SLDASM, and 

Lesson2withresults.SLDASM. You can find 

these files at the publ isher ' s web site 

(ht1p: / /www.schroff lxom/) . We will start 

wi th Lesson2.SLDASM, in which the ball is 

fully assembled to the ground; i.e., no 

movemen t is allowed. In addition, the 

assembly file Lesson2withresults.SLDASM 

consists of a complete simulation model 

with simulation results, in which some of the 

assembly mates were suppressed in order to 

provide adequate degrees of freedom for the 

ball to move . You m a y want to open this file 

to see h o w the ball is supposed to move . 

Since the gravity is defined in the negative 

7-direction of the global coordinate system 

as default, all parts and assembly are created 

for a mot ion simulation that complies with 

the default setting. 

The assembly Lesson2.SLDASM consists of two parts: the ball (ball.SLDPRT) and the ground 

(ground.SLDPRT). The ball is fully assembled with the ground by three assembly mates of three pairs of 

reference planes. They are Front (ball)/Front (ground), Right (ball)/'Right (ground), and Top (ball)/7b/? 

(ground), as shown in Figure 2-3 . The distance between the reference planes Top (ball) and Top (ground) 

is 100 in., which defines the initial posit ion of the ball, as shown in Figure 2-4. The radius of the ball is 10 

in., and the ground is mode led as a 30*500*0.04 in. 3 rectangular block. 

http://www.schrofflxom/


Note that the 7-axis of the global 

coordinate system (located at the 

lower left corner of the SolidWorks 

graphics screen, as shown in Figure 2-

4) is pointing upward, which is 

consistent with the default direction of 

the gravity, but in the opposite 

direction. 

Motion Model 

In this example, the ball will be 

the only movable body. Two assembly 

mates , Distancel and Coincident^, as 

shown in Figures 2-3a and 2-3c, will 

be suppressed to allow the ball to 

m o v e o n the X-Y p lane A s ment ioned R 2 . 4 T h e S o l i d W o r k s A s s e m b l y 
earlier, the ball will be thrown with an 
initial velocity of VQ = 150 in/sec. 

A gravitational acceleration -386 in /sec 2 is defined in the 7-direction of the global coordinate 

system. The ball will reveal a parabolic trajectory due to gravity. A 3D contact constraint will be added to 

characterize the impact be tween the ball and the ground. As discussed earlier, a coefficient of restitution 

C R = 0.75 will be specified to determine the force that acts on the ball when the impact occurs. In this 

example, no friction is assumed. 

2.3 Using COSMOSMotion 

Start SolidWorks and open assembly file Lesson2.SLDASM. 

In this lesson, we will use the IntelliMotion Builder for most of the steps. The IntelliMotion Builder 

is the pr imary interface in COSMOSMotion. It is a tabbed dialog box and a wizard that leads you through 

W h e n COSMOSMotion is active, the browser has an extra tab 

(the Motion button) for the Motion (see the buttons on top of the browser 

shown in Figure 2-5). This browser provides you with a graphical, 

hierarchical v iew of the mot ion model and allows you to access all 

COSMOSMotion functionalities through a combinat ion of drag-and-drop 

and right click menus . 

Switch back and forth between COSMOSMotion and SolidWorks 

assembly mode is straightforward. All you have to do is to click the 

Motion and Assembly but tons 

Motion button 

when needed. When you click the 

to enter COSMOSMotion, a different set of entities 

will be listed in the browser, in addition, an additional toolbar is added to 

SolidWorks, located at the top of the graphics screen, as shown in Figure 

2-6. This toolbar provides settings, simulation and post processing 

features. Especially, the Play Simulation button is handy when you 
finish running a simulation and ready to animate the motion. Click some 

of the buttons and try to get familiar with their functions. 



enter COSMOSMotion. 

Start the IntelliMotion Builder 

To use the IntelliMotion Builder, r ight click the Motion Model node from the browser, and then 

select IntelliMotion Builder (see Figure 2-5). The first tab of the IntelliMotion Builder is Units, which 

brings up the Units page. As shown in Figure 2-9, the IPS units system has been chosen. No action is 

needed. 

Click the Motion button on ton of the browser to 

If you move the cursor to the root node, Lesson2 

(Default<Display State-1>), in the browser, you should see 

a rectangular box appears in the graphics screen, which is 

simply the bounding box for the assembly (see Figure 2-8). 

Choose Distance 1 (Ground< 1 >, ball<1>), press the 

right mouse button, and choose Suppress. Repeat the same 

for Coincident3(Ground<l>,ball<l>). Both mates will 

become inactive. 

Before we start, we will suppress two assembly mates 

to allow the ball to move on the X-Y plane. Choose the 

on top of the browser, and expand the Assembly but ton 

Mates branch by clicking the small button in front of it. 



At the lower-left corner of each page in 

the IntelliMotion Builder are the Back and 

Next but tons, which help you move 

sequentially through the mot ion model 

creation, simulation, and animation process. 

Choose Next or click the Gravity tab. 

The Gravity page (Figure 2-10) shows 

that the default acceleration is 386.22 in / sec 2 

and is acting in the negative 7-direction. This 

is what we want , and no action is needed. 

Choose Next or click the Parts tab. 

Defining Bodies 

The first step in creating a mot ion model is to indicate which components from your SolidWorks 

assembly mode l participating in the mot ion model . In an assembly that does not yet have any motion 

parts defined, all of the assembly components are listed under the Assembly Components branch (right 

column) of the Parts page , as shown in Figure 2 -11 . We will m o v e ball-1 to Moving Parts (left column) 

and Ground-1 to Ground Parts by using the drag-and-drop method. 

Click ball-1 and drag it by holding down the left-mouse button, moving the mouse until the cursor is 

over the Moving Parts node , and then releasing the mouse button. Part ball-1 is n o w added to the mot ion 

model as moving parts (can move) . Repeat the same steps to m o v e ground-1 to the Ground Parts node . 

Now, the part Ground-1 is added to the mot ion model as a ground part (cannot move) . 

Note that you m a y select mult iple components by holding Ctrl key and selecting each component . 

You m a y select mult iple components by selecting the first component , pressing and holding Shift key, and 

then selecting the last component . All of the components between the first and second selected 

components will be selected. Or you can drag-select by pressing the left-mouse but ton and moving the 



mouse so that the selection rectangle intersects the components . In this case, any components within the 

selection rectangle will be selected. 

A n y t ime a component (a part or an assembly) is added to the mot ion model , COSMOSMotion looks 

at all of the assembly mates that are at tached to that component . If an assembly mate between the newly 

added component and another component that is already participating in the motion model is found, a 

mot ion jo int that maps to the assembly mate is generated. This allows you to take a fully assembled 

model and quickly build a simulation-ready mot ion model by indicating which components from the 

assembly participate in the mot ion model . A list of mappings between the assembly and mot ion joints that 

are frequently encountered can be found in Appendix A. Take a few minutes to review Appendix A to 

become more familiar with the mapping and the joint types supported in COSMOSMotion. Understanding 

joints and the mapping will help you assemble parts adequately for mot ion models , avoiding unnecessary 

model editing and confusion. 

Defining Initial Velocity 

We will add an initial velocity Vox =150 in/sec to the 

ball. Click ball-1 from the Parts page , press the right 

mouse button, and choose Properties (see Figure 2-12), the 

Edit Part dialog box will appear. Click the IC's tab and 

enter 150 for X Velocity, as shown in Figure 2-13. Click 

Apply. The initial velocity has been defined. 

Defining Joints 

Choose Next or click the Joints tab. The Joints page 

allows you to modify joints that were automatically 

created f rom assembly mates . Y o u m a y add additional 

joints to the motion model if adequate. This page contains 

a single tree that lists all of the joints in the mot ion model . 

As shown in Figure 2-14, there is only one jo int listed, 

Coincident!, which mates Front Plane of ball to the Front 

Plane of the ground to allow a planar mot ion for the ball. 



On the right, you will see a list of jo in t types you can choose to add to your motion model . The first 

jo in t Revolute is selected by default. As indicated in the message, a revolute jo in t removes five degrees of 

freedom, three translational and two rotational. However , for this bal l- throwing example, the jo in t carried 

over from SolidWorks; i.e., Coincident2, is exactly what we want; therefore, no action is needed for the 

t ime being. 

Running Simulation 

Click the Next but ton three t imes or click the Simulation tab directly (no spring or driver is needed 

for this example; therefore, we are skipping the Spring and Motion tabs). As shown in Figure 2-15, the 

simulation duration is 1 second and the number of frames is 50 as defaults. We will stay with these 

default values for the t ime being. Click Simulate to run a simulation. 



After a few seconds, the ball will start moving. As shown in Figure 2-16 the ball will fall through the 

ground, which is not realistic. Note that the trace path that indicates the trace of the center of the ball is 

turned on in Figure 2-16. We will learn h o w to do that later. For the t ime being we will have to add a 3D 

Contact constraint be tween the ball and the ground in order to make the ball bounce back w h e n it hits the 

ground. The 3D Contact constraint will create a force to prevent the ball from penetrating the ground. 

This constraint will be only activated if the ball comes into contact with the ground. 

Defining a 3D Contact Constraint 

The 3D Contact constraint cannot be created in the 

IntelliMotion Builder. We will have to use the browser or the pull­

down menu. Before creating a 3D Contact constraint, close the 

IntelliMotion Builder, and delete the simulation result by clicking the 

Delete Results but ton JIL at the bot tom of the browser (see Figure 

2-17 for the location of the delete button). Now, the ball should 

return to its initial position. Also, save your model before moving 

forward. 

F rom the pul l -down menu, choose 

COSMOSMotion > Contacts > 3D Contact 

or from the browser, right click the Contact branch, and then select 

Add 3D Contact, as shown in Figure 2-17. The Insert 3D Contact 

dialog box will appear (Figure 2-18). 



COSMOSMotion calculates whether the parts' bounding boxes (usually the rectangular box, similar to thai 

of Figure 2-8, but for individual parts) interfere. If they interfere, COSMOSMotion performs a finer 

interference calculation between the two bodies. At the same t ime, ADAMS/Solver computes and applies 

an impact force on both bodies. 

From the browser, select Ground-7, the ground part will be listed in the first container (upper field), 

as shown in Figure 2-18. Click the Add Container for contact pairs but ton (in the middle) , and pick ball-1 

The part ball-1 will be listed in Container 2 ( lower field). 

Click the Contact tab to define contact parameters . Note that we will define a coefficient of 

restitution for the impact. In the three sets of parameters appearing in the dialog box (Figure 2-19). turn 

off the Use Materials (deselect the entity) and Friction (click None). Choose Coefficient of Restitution I in 

the middle) , and enter 0.75 for Coefficient Restitution, as shown in Figure 2-19. Click Apply to accept the 

3D Contact. The 3D Contact constraint should appear in the browser, as shown in Figure 2-20. You wi l l 

have to expand the Constraints branch and then the Contact branch to see the contact constraint. 

Rerun the Simulation 

Before we rerun the simulation, we will have to adjust some of the simulation parameters . Especially 

we will ask COSMOSMotion to use precise geometry to check contact in each frame of simulation. 

Right click the Motion Model node from the browser and choose Simulation Parameters. In the 

COSMOS Education Edition Options dialog box appearing (Figure 2-21), choose Use Precise Geo/?;, 

for 3D Contact, and enter 3 seconds for Duration and 500 for Number of Frames. Note that we increase 

the number of frame so that we will see smooth graphs in various result displays. Increasing the number 

of frame will certainly increase the simulation t ime. However , the increment is insignificant for this 

simple example. Click OK io accept the definition and close the dialog box. 

Right click the Motion Model node from the browser and choose Run Simulation. After a few 

seconds, the ball starts moving. As shown in Figure 2-22 the ball will hit the ground and bounce back a 



few t imes before the simulation ends. The ball did not fall through the ground this t ime due to the 
addition of the 3D Contact constraint. 

Displaying Simulation Results 

COSMOSMotion allows you to graphically display the path that any point on any moving part 

follows. This is called a trace path. Note that the trace path of the ball was displayed in both Figures 2-16 

and 2-22. We will first learn h o w to create a part trace path. 

From the browser, right click the Results node, and choose Create Trace Path (see Figure 2-23) to 

bring up the Edit Trace Path dialog box, as shown in Figure 2-24. Note that Assem2 should be listed in 

the Select Reference Component text box, which serves as the default reference frame for the trace path. 

The default reference frame is the global reference frame included as part of the ground body. No change 

is needed. 

To select the part used to generate the trace curve, select the Select Trace Point Component text field 

(should be highlighted in red already), and then select one moving part; i.e., the ball, from the graphics 

screen. The part ball-1 will be listed in the Select Trace Point Component text field, and ball-

l/DDMFace2 is listed in the Select Trace Point on the Trace Point Component text box. 

Click Apply button, you should see the trace path appears in the graphics screen, similar to that of 

Figure 2-22. 

Next , we will create a graph for the 7-position of the ball using the XY Plots. F rom the browser, r ight 

click ball-1 (under Parts, Moving Parts) and choose Plot > CM Position > Y. 

The XY Plot for the CM (Center of Mass) posit ion of the ball in the 7-direction will appear, similar 

to that of Figure 2-25. Note that you m a y adjust properties of the graph, for instance the axis scales, 

following steps similar to those of Microsoft® Excel spreadsheet graphs. 

The graph shows that the ball was thrown from Y= 100 in. and hits the ground at Y= 10 in. (CM of 

the ball) and t ime about t— 0.6 seconds. The ball bounces back and moves up to an elevation determined 

by the coefficient of restitution. The mot ion continues until reaching the end of the simulation. 



Note that you m a y click any location in the graph to bring up a fine red vertical line that correlates 

the graph with the posit ion of the ball in animation. As shown in the graph of Figure 2.25, at t = 1.4 

seconds, the ball is roughly at Y= 44 in. The snapshot of the ball at that specific t ime and 7-location is 

shown in the graphics screen. 



turned off all friction for the 3D Contact constraint earlier, therefore, no energy loss due to contact. 

Figure 2-27 shows 7-velocity of the ball. The ball moves at a linear velocity due to gravity. The 7-

velocity is about -263 in/sec at t = 0.67 seconds. Y o u m a y see this data by moving the cursor close to the 

corner point of the curve and leave the cursor for a short period. The data will appear. 

Y o u m a y also convert the XY Plot data to Microsoft® Excel 

spreadsheet by simply moving the cursor inside the graph and 

right click to choose Export CSV. Open the spreadsheet to see 

more detailed simulation data. From the spreadsheet (Figure 2-28), 

the 7-velocity right before and after the ball hits the ground are 

-264 and 198 in/sec, respectively. The ratio of 198/264 is about 

0.75, which is the coefficient of restitution we defined earlier. 

of the graphics screen to create an AVI movie for the mot ion 

animation. In the Export A VI Animation File dialog box (Figure 

2-29); s imply click the Preview but ton to review the AVI 

animation. Leave all default data for Frame and Time. Click OK 

to accept the definition. An AVI file will be created in your 

current folder with a file name, Lesson2.avi. You m a y play the 

A VI animation using, for example, Window Media Player. 

Be sure to save your model before exiting from 

COSMOSMotion. 

2.4 Result Verifications 

In this section, we will verify analysis results 

obtained from COSMOSMotion us ing particle dynamics 

theory you learned in high school Physics. 

There are two assumptions that we have to make in 
order to apply the particle dynamics theory to this ball-
throwing problem: 

(i) The ball is of a concentrated mass , and 

(ii) No air friction is present. 

Equation of Motion 

It is wel l -known that the equations that describe the 

posit ion and velocity of the ball are, respectively, 

on top In addition, you m a y use the Export A VI button 



where P x and P y are the X- and 7-positions of the ball , respectively; V x and V y are the X- and 7-velocities, 

respectively; P0x and P0y are the initial posit ions in the X- and 7-directions, respectively; V0x and Vgy are 

the initial velocities in the X- and 7-directions, respectively; and g is the gravitational acceleration. 

These equations can be implemented using, for example, Microsoft® Excel spreadsheet shown in 

Figure 2-30, for numerical solutions. In Figure 2-30, Columns B and C show the results of Eqs. 2.1a and 

2.1b, respectively; with a t ime interval from 0 to 3 seconds and increment of 0.01 seconds. Columns D 

and E show the results of Eqs. 2.2a and 2.2b, respectively. 

Note that when the ball hits the ground, we will 

have to reset the velocity to 7 5 % of that at the prior 

time step and in the opposite direction. 

Data in column C is graphed in Figure 2 -31 . 

Columns D and E are graphed in Figure 2-32. 

C omparing Figure 2-31 with Figure 2-25 and Figure 2-

32 with Figures 2-26 and 2-27, the results obtained 

from theory and COSMOSMotion are very close, which 

- :eans the dynamic model has been created properly in 

JSMOSMotion, and COSMOSMotion does its j o b and 

gives us good results. Note that the solution spreadsheet 

am be found at the publ isher ' s websi te (filename: 

. on2.xls). 



thrown at an initial velocity of 

shown in Figure E 2 - 1 . 

from an elevation of 750 in., as 

1. Use the same mot ion model to conduct a simulation for a different scenario. This t ime the ball is 

2. A 1 "xl "xl" b lock slides from top of a 

E2-2. The material of the block and the slope is AL2014. 

slope (due to gravity) wi thout friction, as shown in Figure 

(i) Create a dynamic simulation model using COSMOSMotion to simulate the trajectory of the 

ball. Report position, velocity, and acceleration of the ball at 0.5 seconds in both vertical and 

horizontal directions obtained from COSMOSMotion. 

(ii) Derive and solve the equations that describe the posit ion and velocity of the ball. Compare your 

solutions with those obtained from COSMOSMotion. 

(iii) Calculate the t ime for the ball to reach the ground and the distance it travels. Compare your 

calculation with the simulation results obtained from COSMOSMotion. 

(i) Create a dynamic simulation model using COSMOSMotion to analyze mot ion of the block. 

Report position, velocity, and acceleration of the block in both vertical and horizontal 

directions at 0.5 seconds obtained from COSMOSMotion. 

(ii) Create a LimitDistance mate to stop the block when its front lower edge reaches the end of the 

slope. You m a y want to review COSMOSMotion help m e n u or preview Lesson 3 to learn more 

about the LimitDistance mate . 

(iii) Derive and solve the equation of mot ion for the system. Compare your solutions with those 

obtained from COSMOSMotion. 



3.1 Overview of the Lesson 

In this lesson, we will create a simple spring-mass system and simulate its dynamic responses under 

various scenarios. A schematics of the system is shown in Figure 3 -1 , in which a steel b lock of V'xV'xl" 

is sliding along a 30° slope with a spring connecting it to the top end of the slope. The block will slide 

back and forth along the slope under three different scenarios. First, the block will slide due to a small 

initial displacement, essentially, a free vibration. For the second scenario, we will add a friction between 

the b lock and the slope face. Finally, we will remove the friction and add a sinusoidal force p(t)9 

therefore, a forced vibration. Gravity will be turned on for all three scenarios. In this lesson, you will 

learn h o w to create the spring-mass model , run a mot ion analysis, and visualize the analysis results. In 

addition, you will learn h o w to add a friction to a joint , in this case, a planar (or coincident) joint . The 

analysis results of the spring-mass example can be verified using particle dynamics theory. Similar to 

Lesson 2, we will formulate the equation of motion, solve the differential equations, graph posit ions of the 

block, and compare our calculations wi th results obtained from COSMOSMotion. Specifically, we will 

focus on the first and the last scenarios; i.e., free and forced vibrations, respectively. 

3.2 The Spring-Mass System 

Physical Model 

Note that the IPS units system will be used for this 

example. The spring constant and unstretched length (or 

free length) are k = 20 lbf/in. and U = 3 in., respectively. 

As ment ioned earlier, the first scenario assumes a free 

vibration, where the b lock is stretched 1 in. downward 

along the 30° slope. Friction will be imposed for 

Scenario 2, in which the friction coefficient is assumed jU 

= 0.25. In the third scenario, an external force p(t) = 10 

cos 360t l b f is applied to the block, as shown in Figure 

3 -1 . All three scenarios will assume a gravity of g = 386 

in /sec 2 in the negat ive 7-direction. All three scenarios 

will be simulated using COSMOSMotion. 

SolidWorks Parts and Assembly 

For this lesson, the parts and assembly have been created for you in SolidWorks. There are six files 

created, block. SLDPRT, ground. SLDPRT, Lesson3. SLDASM, Lesson3Awithresults. SLDASM, 

Lesson3Bwithresults.SLDASM, and Lesson3Cwithresults.SLDASM. Y o u can find these files at the 

publ isher ' s web site (ht tp: / /www.schroff l .com/) . We will start with Lesson3.SLDASM, in which the block 

http://www.schroffl.com/


is assembled to the ground and no mot ion entities have been added. In addition, the assembly files 
Lesson3Awithresults. SLDASM, Lesson3Bwithresults. SLDASM, and Lesson3Cwithresults. SLDASM 

contain the complete simulation models with simulation results for the three respective scenarios. 

In the assembly models , there are three assembly mates, Coincidentl(ground<l>,block<l>), 

Coincident3(ground<l>,ball<l>), and LimitDistancel(ground<l>,ball<l>), as shown in Figure 3-2. 
m 

The block is al lowed to m o v e along the slope face. If you choose the Move Component but ton componenton 

top of the graphics screen, and drag the block in the graphics screen, you should be able to move the 

block on the slope face, but not beyond the slope face. This is because the third mate is defined to restrict 

the b lock to m o v e be tween the lower and upper limits. We will take a look at the assembly mate 

LimitDistance 1. 

From the browser, righ-click the third mate , 

LimitDistance 1, and choose Edit Feature. The mate is 

brought back for reviewing or editing, as shown in 

Figure 3-3. Note that the distance be tween the two faces 

(Face<2>@block-l and Face<l>@ground-l, see 

Figure 3-2c) is 3.00 in., which is the neutral posit ion of 

the block when the spring is undeformed. The upper and 

lower limits of the distance are 9.00 and 0.00 in., 

respectively. The length of the slope face is 10 in., 

therefore, the upper limit is set to 9.00 in., so that the 

b lock will stop when its front lower edge reaches the end 

of the slope face. Note that you will have to choose 

Advanced Mates in order to access the limit fields. 

Motion Model 

A spring with a spring constant k = 20 lb f/in. and an 

unstretched length U = 3 in. will be added to connect the 

b lock (Face<2>, as shown in Figure 3-2c) with the 

ground (Face<l>). 

The block is al lowed to m o v e along the slope face. If you choose the Move Component but ton on 

top of the graphics screen, and drag the block m the graphics screen, you should be able to move the 

block on the slope face, but not beyond the slope face. This is because the third mate is defined to restrict 

the b lock to m o v e between the lower and upper limits. We will take a look at the assembly mate 

LimitDistancel. 



By default, the ends of the spring will connect to the center of the corresponding square faces (see 

Figure 3-4). No reference points are needed. 

This model is adequate to support a free vibration simulation under the first scenario. Note that we 

will m o v e the b lock 1 in. downward along the slope face for the simulation. This can be accomplished by 

changing the distance from 3 to 4 in. in the LimitDistancel assembly mate . 

Note that before entering COSMOSMotion we 

will suppress two assembly mates , Coincident^ and 

LimitDistancel, and only keep Coincident 1 in order 

for COSMOSMotion to impose a planar (or 

coincident) jo int be tween the block and the slope 

face. Y o u m a y unsuppress these mates when you 

want to make a change to the assembly, for example, 

moving the block back to its initial position. 

As ment ioned earlier, a friction force will be 

added be tween the b lock and the slope face for 

Scenario 2. In addition, a sinusoidal force p(t) = 10 

cos 360t will be added to the block for the 3rd 

scenario. Gravity will be turned on for all three 

scenarios. 

3.3 Using COSMOSMotion 

Start SolidWorks and open assembly file Lesson3.SLDASM. 

Before entering COSMOSMotion, we will suppress two assembly mates , Coincident3 a n d 

LimitDistancel. F rom the Assembly browser, expand the Mates branch, right click Coincident3, and 

choose Suppress. The mate Coincident3 will become inactive. Repeat the same to suppress 

LimitDistancel. Save your model . 

C h o o s e t h e Document Properties t a b in t h e System Options - General d i a l o g b o x , c l i ck t h e Units 

n o d e . Y o u s h o u l d s ee t h a t the IPS units system has been chosen. In this units system, the gravity is 386 

in/sec 2 in the negat ive 7-direction of the global coordinate system by default. No change is needed. 

Defining Bodies 

From the browser, expand the Assembly Components branch (right underneath the Motion Model 

node) by clicking the small + but ton in front of it. Y o u should see two parts listed, block-1 and ground-7, 

F rom the browser, click the Motion button on top to enter COSMOSMotion. 

In this lesson, instead of using IntelliMotion Builder (as in Lesson 2), we will use the browser, and 
basic drag-and-drop and right click activated menus to create and simulate the block motion. 

Before creating any entities, a lways check the units system. Similar to Lesson 2, choose from the 

nul l -down menu 



as shown in Figure 3-5. Also expand the Parts branch; you should see Moving Parts and Ground Parts 

listed. We will move block-1 to Moving Parts and ground-1 to Ground Parts by using the drag-and-drop 

method. 

Click block-1 and drag it by holding down the 

left-mouse button, moving the mouse until the 

cursor is over the Moving Parts node, and then 

releasing the mouse button. Part block-1 is now 

added to the mot ion model as moving parts. Repeat 

the same steps to move ground-1 to the Ground 

Parts node. N o w , the part ground-1 is added to the 

mot ion model as a ground part (completely fixed, 

as shown in Figure 3-6). 

Expand the Constraints branch, and then the 

Joints branch. You should see that only one joint, 

Coincident1, is listed. Expand the Coincident! 

branch to see that the assembly mate is defined 

be tween ground-! and block-1. Since this 

coincident jo int restricts the block to move on the 

slope face of the ground, it is therefore a planar 

joint . A planar jo in t symbol should appear in the 

mot ion model , as shown in Figure 3-4. 

Defining Spring 

From the browser, r ight click the Spring node and choose Add Translational Spring (see Figure 3-7). 

In the Insert Spring dialog box (Figure 3-8), the Select 1st Component field is highlighted in red and 

ready for you to pick. Pick the face at top right of the ground (see Figure 3-9), the Select 2nd Component 

field should n o w highlight in red, and ground l/DDMFace4 should appear in the Select Point on 1st 

Component field, which indicates that the spring will be connected to the center point of the face. 

Rotate the view, and then pick the face in the block, as shown in Figure 3-9. N o w , block-1 and 

block-l/DDMFace3 should appear in the Select 2nd Component field and Select Point on 2nd Component 

field, respectively. Also, a spring symbol should appear in the graphics screen, connecting the center 

points of the two selected faces. 



and choose Unsuppress. Right click the same assembly mate and choose Edit Feature. You should see the 

definition of the assembly mate in the dialog box like that of Figure 3-3. Change the distance from 3.00 to 

4.00 in., and click the checkmark on top to accept the change. In the graphics screen, the block should 

move 1 in. downward along the slope face. Click the checkmark again to close the assembly mate box. 

Right c l i ckLimi tDi s tance l ( z round<l> ,ba l l< l>) again and choose Suppress. 

Go back to Assembly by clicking the Assembly button on top of the browser. 

We would like to stretch the spring 1 in. downward along the slope face as the initial posit ion for the 
block. The block will be released from this position to simulate a free vibration; i.e., the first scenario. We 
will go back to the Assembly mode , unsuppress LimitDistancel, change the distance dimension from 3 to 
4 in., and then sunnress the mate before returning to COSMOSMotion. 

Defining Initial Position 

Expand the Mates branch listed in the browser, right click 

Go back to COSMOSMotion by clicking the Motion but ton (y . Click the Motion Model node, press 

the right mouse button and select Simulation Parameters. Enter 0.25 for simulation duration and 500 for 

the number of frames. 

Click the Motion Model node again, press the right mouse button and select Run Simulation. Y o u 

may also click the Run Simulation but ton | J | ] right be low the browser to run a simulation. You should see 

the block start moving back and forth along the slope face. We will graph the posit ion of the block in 

terms of the magni tude (instead o fX- or 7-component) next. 



Displaying Simulation Results 

Since there is no posit ion graph defined for the block, we will have to create one. We will create a 

graph for the distance between the two faces that were selected to define the spring. 

F rom the browser, expand the Results branch, right click 

the Linear Disp node, and choose Create Linear Displacement 

(Figure 3-10). In the Insert Linear Displacement dialog box 

(Figure 3-11), the Select First Component field should be 

highlighted in red and ready for you to pick. This dialog box is 

very similar to the upper half of the Insert Spring dialog box 

(Figure 3-8). We will select exactly the same two faces shown 

in Figure 3-9 for this displacement. 

Similar to the spring, pick the face of the ground (see 

Figure 3-9). Rotate the view, and then pick the face in the 

block, as shown in Figure 3-9. A straight line that connects the 

center points of these two faces appears, as shown in Figure 3-

12. Click Apply but ton to accept the definition. 

Next , we will create a graph for the displacement of the 

block using the XY Plots option. This posit ion graph should 

reveal a sinusoidal function as we have seen in many 

vibration examples of Physics. 

From the browser, right click LDisplacement > Plot > 

Magnitude (see Figure 3-13). A graph like that of Figure 3-14 

should appear. F rom the graph, the block moves along the 

slope face between 2 and 4 in. This is because the unstretched 

length of the spring is 3 in. and we stretched the spring 1 in. 

to start the motion. Also, it takes about 0.04 seconds to 

complete a cycle, which is small. The small vibration period 

can be attributed to the fact that the spring is fairly stiff (20 

lb f/in). 



Note that you can also export the graph 

data, for example, by right clicking the graph 

and choosing Export CSV. Open the 

spreadsheet and exam the data. The t ime for the 

block to move back to its initial posit ion; i.e., 

when the distance is 4 in., is 0.037 seconds. 

We will carry out calculations to verify 

these results later in Section 3.4. Before we do 

that, we will work on two more scenarios: with 

frict ion and with the addition of an external 

force. Save your model before moving to the 

next scenario. Y o u may save the model under 

different name and use it for the next scenario. 

Scenario 2: With Friction 

Note that for calculating friction effects, 

COSMOSMotion models a planar jo in t as one block 

sliding and rotating on the surface of another block, as 

illustrated in Figure 3-15, where 

L is the length of the top (sliding) rectangular block, 

W is the width of the top rectangular block, and 

R is the radius of a circle, centered at the center of the 

top b lock face in contact with the bot tom block, which 

circumscribes the face of the sliding block. 

Expand the Constraints branch and then the Joints branch. Right click the Coincident! node and 

choose Properties. In the Edit Mate-Defined Joint dialog box, choose the Friction tab, click the Use 

Friction, enter 0.25 for Coefficient (mu), and enter Joint dimensions, Length: 1, Width: 1, and Radius: 

1.414, as shown in Figure 3-17. Click Apply button to accept the definition. 

Run a simulation (with the same simulation parameters as those of Scenario T). Graph the 

displacement of the block; you should see a graph similar to that of Figure 3-18. The ampli tude of the 

graph (that is, the distance the block travels) is decreasing over t ime due to fr ict ion. Save your model . We 

will m o v e into Scenario 3. You may save the model again under different name and use it for the next 

scenario. 

Delete Results button 

to delete the results. 

at the bot tom of the browser 

We will add a friction force to the planar jo in t 

{Coincident 1) be tween the block and the ground. The 

friction coefficient is ju = 0.25. Before making any 

change to the definition of the simulation model , we 

will have to delete existing simulation results. Click the 



Right click the Coincidentl node and choose Properties. In the Edit Mate-Defined Joint dialog box, 

choose the Friction tab, and deselect the Use Friction by clicking the small box in front of it. All 

parameters and selections on the dialog box should become inactive. Click Apply but ton to accept the 

change. 

The force can be added by expanding the Forces branch, right clicking the Action Only node, and 

choosing Add Action-Only Force, as shown in Figure 3-19. In the Insert Action-Only Force dialog box 

(see Figure 3-20), the Select Component to which Force is Applied field will be active (highlighted in red) 

and ready for you pick the component . 

Pick the end face of the block, as shown in Figure 3-21 . The part block-1 is n o w listed in the Select 

Component to which Force is Applied field, and block-l/DDMFace8 is listed in both the Select Location 

and the Select Direction fields. That is, the force will be applied to the center of the selected end face and 

in the direction that is normal to the selected face. 

N o w in the Insert Action-Only Force dialog box, the Select Reference Component to orient Force 

field is active (highlighted in red) and is ready for selection. We will p ick the ground part for reference. 

Pick any place in the ground part, ground-1 will n o w appear in the Select Reference Component to orient 

Force field. 

results by clicking the Delete Results button at the bot tom of the browser. 

In this scenario we will add an external force p(t) = 10 cos 360t at the center of the end face of the 

block in the downward direction along the slope. At the same t ime, we will remove the friction in order to 

simplify the problem. 

Before creating a force, we will delete the simulation results and remove the friction. Delete the 



Click the Function tab (see Figure 3-22), choose 

Harmonic, and enter the followings: 

Amplitude: 10 

Frequency: 360 

Phase Shift: -90 

Note that the -90 degrees entered for Phase Shift is to 

convert a sine function (default) to the desired cosine 

function. 

Click the graph button (right most and circled in 

Figure 3-22); the sinusoidal force function will 

appear like the one in Figure 3-23. This is indeed the 

cosine function p(t) = 10 cos 360t we wanted to 

define. 

Close the graph and click Apply but ton to accept 

the force definition. Y o u should see a force symbol 

added to the block, as shown in Figure 3-4. 

F rom the browser, r ight click the Motion Model 

node, and choose Simulation Parameters. Change the 

simulation duration to 0.5 seconds (in order to see a 

graph later that covers a larger t ime span). Note that 

the 0.5-second duration is half the harmonic function 

period of the force applied to the block. 

F rom the browser, right click the Motion Model 

node again, and choose Run Simulation. After 2 to 3 

seconds, the block starts moving. 

Note that in some occasions, the block may slide out of the slope face during the simulation, as 

shown in Figure 3-24. When this happens , simply unsuppress the assembly mate ; for example, 

Coincident3, to restricts the block to stay on the slope face. 



After unsuppressing Coincident3, the planar jo in t 

will become a translational jo int (converted by 

COSMOSMotion) composed of two assembly mates , 

Coincident 1 and Coincident^. Please refer to the 

assembly file Lesson3Cwithresults.SLDASM for the 

translational jo in t employed for this example. 

Rerun a simulation if necessary. As soon as the 

simulation is completed, a graph like that of Figure 3-

25 should appear. F rom the graph, the block moves 

along the slope face roughly for 2 in. back and forth 

(since friction is turned off). The vibration ampli tude 

is enveloped by a cosine function due to the external 

force p(t). Also, it takes about 0.04 seconds to 

complete a cycle, which is unchanged from the 

previous case. We will carry out calculations to verify 

these results later. Save your model . 

Figure 3-25 The Displacement Graph: Scenario 3 

In this section, we will verify analysis results of 

Scenarios 1 and 3 obtained from COSMOSMotion. We 

will assume that the block is of a concentrated mass so 

that the particle dynamics theory is applicable. 

We will start with Scenario 1 (i.e., free vibration 

with gravity), and then solve the equations of mot ion for 

Scenario 3 (forced vibration, no friction). 

Equation of Motion: Scenario 1 

From the free-body diagram shown in Figure 3-26, applying N e w t o n ' s Second L a w and force 

equil ibrium along the X-direction (i.e., a long the 30° slope), we have 



where m is the mass of the block, U is the unstretched length of the spring, x is the distance between the 

mass center of the block and the top right end of the slope, measured from the top right end. 

The double dots on top of x represent the second derivative of x wi th respect to t ime. Rearrange Eq. 

3.2, we have 

mx + kx = mgsin 0 + Uk (3.3) 

where both terms on the right are t ime-independent . 

This is a second-order ordinary differential equation. It 

is well known that the general solution of the differential 

equation is 

Note that the pound-mass unit l b m is not as c o m m o n as slug that we are more familiar with. The 

corresponding force unit of l b m i s l b m in / sec 2 according to N e w t o n ' s Second Law. 

determined with initial conditions. Note that the mass of the 

steel b lock is 0.264 l b m . This can be obtained from 

SolidWorks by opening the block part file, and choosing, 

from the pul l -down menu, Tools > Mass Properties. F rom 

the Mass Properties dialog box (Figure 3-27), the mass of 

the b lock is 0.264 pounds (pound-mass, l b m ) . Note that 

there are 2 decimal points set in SolidWorks by default. Y o u 

m a y increase it through the Document Properties - Units 

dialog box (choose from pul l -down menu, Tools > 

Options). 



Equat ion 3.7 can be implemented into Microsoft® Excel 

spreadsheet, as shown in Figure 3-28. Column B in the 

spreadsheet shows the results of Eq. 3.7, which is graphed in 

Figure 3-29. Compar ing Figure 3-29 with Figure 3-14, the 

results obtained from theory and COSMOSMotion agree very 

well , which means the mot ion model has been properly 

defined, and COSMOSMotion gives us good results. 

Equation of Motion: Scenario 3 

Refer to the free-body diagram shown in 

Figure 3-26 again. For Scenario 3 we must include 

the force p = fo cos (cot) a long the X-direction for 

force equilibrium; i.e., 



where the r ight-hand side consists of constant and t ime-dependent terms. For the constant terms, the 

particular solution is identical to that of Scenario 1\ i.e., Eq. 3.5. For the t ime-dependent term, p = f 0 

cos (cot), the particular solution is 

Note that terms grouped in the first 

bracket of Eq. 3.12 are identical to those 

of Eq. 3.7; i.e., Scenario 1. The second 

term of Eq. 3.12 graphed in Figure 3-30 

represents the contribution of the external 

force p(t) to the block motion. The graph 

shows that the ampli tude of the b lock is 

kept within 1 in., but the posit ion of the 

block varies in t ime. The vibration 

ampli tude is enveloped by a cosine 

function. 

The overall solution of Scenario 3; 

i.e., Eq. 3.12, is a combinat ion of graphs 

shown in Figures 3-29 and 3-30. In fact, 

Eq. 3.12 has been implemented in Column 

C of the spreadsheet. The data are graphed 

in Figure 3-31. 

Compar ing Figure 3-31 with Figure 3-25, the results obtained from theory and COSMOSMotion are 

very close. Note that the spreadsheet shown in Figure 3-28 can be found at the publ isher ' s websi te 

(filename: lesson3.xls). 





Exercises: 

1. Show that Eq. 3.12 is the correct solution of Scenario 3 governed by Eq. 3.8 by simply plugging Eq. 
3.12 into Eq. 3.8. 

2. Repeat the Scenario 3 of this lesson, except changing the external force to p(t) = 10 cos 9798. Ot l b f . 

Will this external force change the vibration ampli tude of the system? Can you simulate this 
resonance scenario in COSMOSMotion! 

3. A d d a damper with damping coefficient C = 0.01 l b f sec/in. and repeat the Scenario 1 simulation 

using COSMOSMotion. 

(i) Calculate the natural frequency of the system and compare your calculation with that of 
COSMOSMotion. 

(ii) Derive and solve the equations that describe the posit ion and velocity of the mass . Compare 
your solutions with those obtained from COSMOSMotion. 





4.1 Overview of the Lesson 

In this lesson, we will create a simple pendulum mot ion model using COSMOSMotion. The 

pendulum will be released from a posit ion slightly off the vertical line. The pendulum will then rotate 

freely due to gravity. In this lesson, you will learn h o w to create the pendulum mot ion model , run a 

dynamic analysis, and visualize the analysis results. The dynamic analysis results of the simple pendulum 

example can be verified using particle dynamics theory. Similar to Lessons 2 and 3, we will formulate the 

equation of mot ion; calculate the angular position, velocity, and acceleration of the pendulum; anc 

compare our calculations with results obtained from COSMOSMotion. 

4.2 The Simple Pendulum Example 

Physical Model 

The physical model of the pendulum is composed 

of a sphere and a rod rigidly connected, as shown in 

Figure 4 - 1 . The radius of the sphere is 10 m m . The 

length and radius of the thin rod are 90 mm and 0.5 

m m , respectively. The top of the rod will be connected 

to the wall with a revolute joint . This revolute jo in t 

allows the pendulum to rotate. Both rod and sphere are 

made of Alunimum. Note that from the SolidWorks 

material library the Aluminum Alloy 2014 has been 

selected for both sphere and rod. The MMGS units 

system is selected for this example (millimeter for 

length, Newton for force, and second for t ime). Note 

that in the MMGS units system, the gravitational 

acceleration is 9,806 mm/sec 2 . 

The pendulum will be released from an angular 

posit ion of 10 degrees measured from the vertical 

posit ion about the rotational axis of the revolute joint . 

The rotation angle is intentionally kept small so that the 

particle dynamics theory can be applied to verify the 

simulation result. 



You can f ind these f i les at the publ isher ' s w e b site (ht tp: / /www.schroff l .com/) . We will start with 

Lesson4.SLDASM, in which the pendulum is fully assembled to the ground. In addition, the assembly file 

Lesson4withresults.SLDASM consists of a complete simulation model with simulation results. 

http://www.schroffl.com/


4-3 

From top of the browser, click the Motion but ton $ to enter COSMOSMotion. 
Before creating any entities, a lways check the units system. Make sure that MMGS is chosen. 

F rom top of the browser, click the Motion button to enter COSMOSMotion. 

Defining Bodies 

From the browser, expand the Assembly Components 

branch (right underneath the Motion Model node) by 

clicking the small H button in front of it. You should see 

two parts listed, ground-1 and pendulum-7, as shown in 

Figure 4-4. 

Also expand the Parts branch; you should see Moving 

Parts and Ground Parts listed. Go ahead to m o v e 

pendulum-1 to Moving Parts and ground-1 to Ground Parts 

by using the drag-and-drop method. 

Expand the Constraints branch, and then the Joints 

branch. Y o u should see a Revolute jo in t listed, as shown in 

Figure 4-5 and a revolute jo in t symbol should appear in the 

graphics screen (see Figure 4-3). 



Setting Gravity 

We would like to make sue the gravity is set up properly. F rom the browser, right-click the Motion 

Model node and select System Defaults. In the Options dialog box (Figure 4-6), enter 9806 for 

Acceleration (mm/sec**2) which should appear as default already, and make sure the Direction is set to 

-7 for Y. Click OK to accept the gravity setting. 

Defining and Running Simulation 

Click the Motion Model node, press the right mouse button and select Simulation Parameters. Enter 

1.5 for simulation duration and then 300 for the number of frames. 

Click the Motion Model node again, press the right mouse button and select Run Simulation. You 

should see the pendulum start moving back and forth about the axis of the revolute joint . We will graph 

the position, velocity, and acceleration of the pendulum next. 

Displaying Simulation Results 

The results of angular position, velocity, and acceleration of the pendulum can be directly obtained 

by right clicking the moving part, pendulum-7, from the browser. 

F rom the browser, expand the Parts node and the then Moving Parts node . Right-click pendulum-7, 

and choose Plot > Bryant Angles > Angle 3. 

Note that the Bryant angles are also known as X-Y-ZEuler angles or Cardan angles. They are simply 

the rotation angles of a spatial object along the 7-, and Z-axes of the reference coordinate system. 

Angle 3 is measured about the Z-axis. 

A graph like that of Figure 4-7 should appear. F rom the graph, the pendulum swings about the Z-axis 

be tween -10 and 10 degrees, as expected (since no friction is involved). Also, it takes about 0.6 seconds 

to complete a cycle. Note that you can export the graph data, for example, by right clicking the graph and 

choosing Export CSV. Open the spreadsheet and exam the data. F rom the spreadsheet, the t ime for the 

pendu lum to swing back to its original position; i.e., -10 degrees. , is 0.64 second, as shown in the 

spreadsheet of Figure 4-8. We will carry out calculations to verify these results later. Before we do that, 

we will graph the angular velocity and acceleration of the pendulum. 

The results of angular position, velocity, and acceleration of the pendulum can be directly obtained 

by right clicking the moving part, pendulum-7, from the browser. 



and choose Angular Acceleration > Z Component. Y o u should see graphs like those of Figures 4-9 and 4-

10. Figure 4-9 shows that the angular velocity starts at 0, which is expected. The angular velocity varies 

between roughly -100 and 100 degrees/sec. Also, the angular acceleration varies between roughly -1,000 

and 1,000 degrees/sec 2 . Are these results correct? We will carry out calculations to verify if these graphs 

are accurate. 

4.4 Result Verifications 

In this section, we will verify the analysis results obtained from COSMOSMotion using particle 

dynamics theory. 

There are four assumptions that we have to make in order to apply the particle dynamics theory to 
this simple pendulum problem: 

(i) Mass of the rod is negligible (this is w h y the diameter of the pendulum rod is very small), 

(ii) The sphere is of a concentrated mass , 

(iii) Rotat ion angle is small ( remember the initial conditions we defined?), and 

(iv) No friction is present. 

The pendulum model has been created to comply with these assumptions as much as possible. We 

expect that the particle dynamics theory will give us results close to those obtained from simulation. Two 

approaches will be presented to formulate the equations of mot ion for the pendulum: energy conservation 

and N e w t o n ' s law. 

Energy Conservation 

Referring to Figure 4 - 1 1 , the kinetic energy and potential energy of the pendulum can be written, 
respectively, as 

T = - J 0 (4.1) 



where J is the polar momen t of inertia, i.e., J = m£2\ 

and 

U=mg/(l-<:os 6) 

According to the energy conservation theory, the total 

mechanical energy, which is the sum of the kinetic energy and 

potential energy, is a constant with respect to t ime; i.e., 

F rom the free-body diagram shown in Figure 4-12, the 

equil ibrium equation of momen t at the origin about the Z-axis 

(normal to the paper) can be written as: 



Note that the same equation of mot ion has been derived from two different approaches. The linear 

ordinary second-order differential equation can be solved analytically. 

Solving the Differential Equation 

The above equations represent angular position, 

velocity, and acceleration, of the revolute joint . These 

equations can be implemented into, for example, Excel 

spreadsheet shown in Figure 4 -13 , for numerical 

solutions. Columns B, C, and D in the spreadsheet show 

the results of Eqs. 4.9a, b, and c, respectively, between 0 

and 7.5 seconds with an increments of 0.005 seconds. 

Data in these three columns are graphed in Figures 4-14, 

15, and 16, respectively. Compar ing Figures 4-14 to 16 

with Figures 4-7, 4-9, and 4-10, the results obtained 

from theory and simulation are very close. The motion 

model has been properly defined, and COSMOSMotion 

gives us good results. Note that in the calculation, the 

angular posit ion of the pendulum is set to zero when it 

aligns with the vertical axis; therefore, the pendulum 

swings between -10 and 10 degrees. 



However , even though graphs obtained from COSMOSMotion and spreadsheet calculations are alike 

these results are not identical. This is because that the COSMOSMotion model is not really a simple 

pendulum since mass of the rod is non-zero. If you reduce the diameter of the rod, the COSMOSMotion 

results should approach those obtained through spreadsheet calculations. 



Exercises: 

1. Create a spr ing-damper-mass system, as shown in Figure E 4 - 1 , 

using COSMOSMotion. Note that the unstretched spring length 

is 3 in. The radius of the ball is 0.5 in. and the material is Cast 

Alloy Steel (mass density: 0.2637 l b m / i n 3 ) . 

(i) Find the spring length in the equilibrium condit ion using 

COSMOSMotion. 

(ii) Solve the same problem using N e w t o n ' s laws. Compare 

your results wi th those obtained from COSMOSMotion. 

2. If a force p = 2 l b f is applied to the ball as shown in Figure E4-

1, repeat both (i) and (ii) of Problem 1. 





5.1 Overview of the Lesson 

In this lesson, you will learn h o w to create simulation models for a slider-crank mechanism and 

conduct three analyses: kinematics , interference, and dynamics. More jo int types will be introduced in 

this lesson. You will learn how to select assembly mates to connect parts in order to create a successful 

mot ion model . We will first drive the mechanism by rotating the crank with a constant angular velocity; 

therefore, conducting a kinematic analysis. After we complete a kinematic analysis, we will turn on 

interference checking and repeat the analysis to see if parts collide. It is very important to m a k e sure no 

interference exists be tween parts while the mechanism is in motion. The final analysis will be dynamic, 

where we will add a firing force to the piston for a dynamic analysis. This lesson will start wi th a brief 

overview about the slider-crank assembly created in SolidWorks. At the end of this lesson, we will verify 

the kinematic simulation results using theory and computat ional methods employed for mechanism 

design. 

5.2 The Sl ider-Crank Example 

Physical Model 

The slider-crank mechanism is 

essentially a four-bar l inkage, as shown 

in Figure 5-1. They are commonly 

found in mechanical systems; e.g., 

internal combust ion engine and oil-well 

drilling equipment. For the internal 

combust ion engine, the mechanism is 

driven by a firing load that pushes the 

piston, converting the reciprocal 

mot ion into rotational mot ion at the 

crank. 

In the oil-well drilling equipment, a torque is applied at the crank. The rotational mot ion is converted 

to a reciprocal mot ion at the piston that digs into the ground. Note that in any case the length of the crank 

must be smaller than that of the rod in order to allow the mechanism to operate. This is commonly 

referred to as the G r a s h o f s law. In this example, the lengths of the crank and rod are 3" and 8", 

respectively. 

Note that the units system chosen for this example is IPS (in-lbj-sec). All parts are made of 

Aluminum, 2014 Alloy. No friction is assumed between any pair of the components (parts or 

subassemblies) . 



SolidWorks Parts and Assembly 

The slider-crank system consists of five parts and one subassembly. They are bearing, crank, rod, 

pin, piston, and rodandpin (subassembly, consisting of rod and pin). An exploded v iew of the mechanism 

is shown in Figure 5-2. SolidWorks parts and assembly have been created for you. They are 

bearing.SLDPRT, crank. SLDPRT, rod.SLDPRT, pin.SLDPRTpiston.SLDPRT, and rodandpin.SLDASM. 

In addition, there are three assembly files, Lesson5.SLDASM, Lesson5Awithresults.SLDASM, and 

LessonSBwithresults.SLDASM. Y o u can find these files at the publ isher ' s w e b site. 

We will start wi th LessonS. SLDASM, in which all components are properly assembled. In this 

assembly the bearing is anchored (ground) and all other parts are fully constrained. We will suppress one 

assembly mate in order to allow for movement . 

Same as before, the assembly file 

LessonSAwithresults. SLDASM and 

Lesson5Bwithresults.SLDASM (with firing 

force) consist of complete simulation models 

with simulation results. You may want to open 

these files to see the mot ion animation of the 

mechanism. In these assembly files with 

complete simulation results, a mate has been 

suppressed. Y o u can also see h o w the parts 

m o v e by moving the cursor to the graphics 

screen and press the right mouse button. In the 

m e n u option appearing next, choose Move 

Component, and drag a movable part, for 

example drag the crank to rotate it with 

respect to the bearing. The whole mechanism 

will m o v e accordingly. 

There are eight assembly mates , including five coincident and three concentric, defined in the 

assembly. You m a y want to expand the MateGroupl branch in the browser to see the list of mates . M o v e 

your cursor on any of the mates ; you should see the entities selected for the assembly mate highlighted in 

the graphics screen. 

The first three mates (Concentric 1, Coincident 1, and Coincident!) assemble the crank to the fixed 

bearing, as shown in Figure 5-3a. As a result, the crank is completely fixed. Note that the mate 

Coincident! orients the crank to the upright position. This mate will be suppressed before entering 

COSMOSMotion. Suppressing this mate will allow the crank to rotate with respect the bearing. 

COSMOSMotion will convert these two mates , Concentricl and Coincident 1, to a revolute joint . 

The next two mates (Concentric2 and Coincident^) assemble the rod to the crank, as shown in 

Figure 5-3b. Unl ike the crank, the rod is al lowed to rotate with respect to the crank, leading to another 

revolute jo int in COSMOSMotion. The next two mates (Concentric3 and Coincident4) assemble the 

piston to the pin, al lowing the piston to rotate about the pin. As a result, a revolute jo in t (or a concentric 

jo in t in some cases) will be added between the piston and the pin. The final mate (CoincidentS) eliminates 

the rotation by mat ing two planes, Right Plane of the piston and the Top Plane of the assembly, as shown 

in Figure 5-3c. COSMOSMotion will add a translational jo in t between the piston and the ground. Since 

the translational jo in t is composed of Coincident5 and Coincident4, Concentric3 will be carried over to 

COSMOSMotion as it is. Therefore, instead of a revolute joint , a cylindrical jo int appears in the mot ion 

model . 





Simulation Model 

In this example, after suppressing Coincident COSMOSMotion converts assembly mates to four 

joints : Concentric3 (directly carrying over from assembly mate) , Revolute, Revolute2, and Translational, 

as shown in Figure 5-4. The total number of degrees of freedom of the slider-crank mechan i sm can be 

calculated as follows: 

3 (bodies) x6 (dofs/body) - 2 (revolute) X 5 (dofs/revolute) - 1 (translational) X 5 (dofs/translational) 

- 1 (concentric) x4 (dof s/concentric) 

= 18-19 = -1 

Apparently, there are two redundant d o f s embedded in the mot ion model . Kinematical ly, this 

mechanism is identical to that of the single piston engine presented in Lesson 1. In Lesson 1, instead of 

defining two revolute jo ints , one concentric joint , and one translational joint , the engine example employs 

three cylindrical joints and one translational joint , resulting one free degree of freedom. Since 

COSMOSMotion will automatically detect and remove redundant d o f s during mot ion simulation, we will 

not make any changes to the joints converted from the assembly mates. 

Since the mechanism has one free degree of freedom, either rotating the crank or the rod (about the 

axis of the revolute joints) , or moving the piston horizontally (along the translational joint) will be 

sufficient to uniquely determine the position, velocity, and acceleration of any parts in the mechanism. 

The mechanism will be f i rs t driven by 

rotating the crank at a constant angular 

velocity of 360 degrees/sec. Gravity will be 

turned off. This will be essentially a 

kinematic simulation. This model will also 

serve for interference check. It is very 

important to make sure no interference 

exists be tween parts while the mechanism is 

in motion. The simulation results are 

included in LessonSAwithresults.SLDASM. 

The next and f inal analysis will be 

dynamic, where we will add a firing force to 

the piston for a dynamic simulation. The 

results are included in 

LessonSBwithresults. SLDASM. 

5.3 Using COSMOSMotion 

Start SolidWorks and open assembly file Lesson5.SLDASM. 

Before entering COSMOSMotion, we will suppress the third assembly mate , Coincident2. In this 
lesson, we will use drag-and-drop as well as right-click activated menus , instead of the IntelliMotion 

Builder. 

From the Assembly browser , expand the Mates branch, r ight click Coincident2, and choose Suppress. 

The mate Coincident2 will become inactive. Save your model . 



Before creating any entities, a lways check the units system. M a k e sure IPS units system is chosen 

for this example. 

Defining Bodies 

From the browser, click bearing-1 and drag 

and drop it to the Ground Parts node. Click the 

first part under the Assembly Components node 

(should be crank-1), press the Shift key, and click 

the last part listed under the Assembly Components 

node (should be rodandpin-1). All three 

components will be selected. Drag and drop them 

to the Moving Parts node . 

Expand the Constraints branch, and then the 

Joints branch. Y o u should see that four joints , 

Concentric3, Revolute, Revolute2, and 

Translational, are listed (Figure 5-6). All jo in t 

symbols should appear in the graphics screen, 

similar to that of Figure 5-4. Expand all jo ints in 

the browser and identify the parts they connect. 

Take a look at the jo in t Revolute (connecting crank 

to bearing), where we will add a driver next. 

Driving Joint 

From the browser, expand the Constraints node and then the Joints node. Right click the Revolute 

node and choose Properties (see Figure 5-7). In the Edit Mate-Defined Joint dialog box (Figure 5-8), 

under the Motion tab, choose Velocity for Motion Type, choose Constant for Function, and enter 360 

degrees/sec for Angular Velocity (should appear as defaults), as shown in Figure 5-8. Click Apply to 

accept the definition. We are ready to run a simulation. 

Turning Off Gravity 



Running Simulation 

We will use all default simulation parameters for 

the kinematic analysis. 

Click the Motion Model node, press the right 

mouse button and select Run Simulation. After a few 

seconds, you should see the mechanism starts 

moving. The crank rotates 360 degrees as expected 

and the piston moves a complete cycle, similar to that 

of Figure 5-10, since the default simulation duration 

is 1 second. 

Saving and Reviewing Results 

We will create four graphs for the mechanism: Ap­

position, X-velocity, and X-acceleration of the piston; Figure 5-10 Mot ion Animat ion 

and angular velocity of Revolute2 (between crank and 

rod). 

F rom the browser, expand the Parts branch and then the Moving Parts branch. Right click the 

piston-1 node , and choose Plot > CM Position > X ( s e e Figure 5-11). The graph should be similar to that 

of Figure 5-12. Note that from the graph, the piston moves be tween about 5 and 11 in. horizontally, in 

reference to the global coordinate system, in which the origin of the coordinate system coincides with the 

center point of the hole in the bearing. 

At the starting point, the crank is at the upright position, and the piston is located at 7.42 in. (that is, 

V82 -3 2 ) to the right of the origin of the global coordinate system. Note that the lengths of the crank and 



rod are 3 and 8 in., respectively. W h e n the crank rotates to 90 degrees counterclockwise, the posit ion 

becomes 5 (which is 8-3). When the crank rotates 270 degrees, the piston posit ion is 11 (which is 8+3). 

Repeat the same steps to create graphs for the velocity and acceleration of the piston in the in­

direction. The graphs should be similar to those of Figures 5-13 and 5-14, respectively. If you expand the 

piston-1 node in the browser, you should see there are three entities listed, CM Accel - X-piston-1, CM 

Position -X-piston-1, and CM Velocity-X-piston-1, as shown in Figure 5-15. 

The graph of the angular velocity of the jo in t Revolute2 can be created by expanding the Constraints 

branch and then the Joints branch, right clicking Revolute2 and selecting Plot > Angular Velocity > Z-

Component. The graph should be similar to that of Figure 5-16. An entity, Angular Vel - Z-Revolute2, is 
added under the jo in t Revolute2 in the browser. 

Interference Check 

Next we will learn h o w to perform interference check. COSMOSMotion allows you to check for 

interference in your mechanism as the parts move. You can check any of the components in your 



SolidWorks assembly model for possible interference, regardless of whether a component participates in 

the motion model . Using the interference detection capability, you can find: 

(1) All the interference that occur between the selected components as the mechanism moves through a 

specified range of motion, or 

(2) The place where the first interference occurs between the selected components . The assembly is 

moved to the posit ion where the interference occurred. 

Make sure you have completed a simulation before proceeding to the interference check. Right click 

the Motion Model node in the browser and then select Interference Check. The Find Interferences Over 

Time dialog box appears (Figure 5-17). 

To select the parts to include in the interference check, select the Select Parts to test text field and 

then pick all four components from the graphics screen (or from the browser) . The Start Frame, End 

Frame, and Increment al low you to specify the mot ion frame used as the starting position, final position, 

and increment in be tween for the interference check. We will use the default numbers ; i.e., 1, 51, and 2, 

for the Start Frame, End Frame, and Increment, respectively. Click the Find Now button (circled in 

Figure 5-17) to start the interference check. 

After pressing the Find Now button, the mechanism starts moving , in which the crank rotates a 

complete cycle. At the same t ime, the Find Interferences Over Time dialog box expands. The list at the 

lower half of the dialog box shows all interference conditions detected. The frame, simulation t ime, parts 

that caused the interference, and the vo lume of the interference detected are listed. 

Close the dialog box and save your model . After saving the model , you m a y want to save i t again 

under a different name and use it for the next simulation. 





Creating and Running a Dynamic Analysis 

A force simulating the engine firing load (acting along the negative X-direction) will be added to the 

piston for a dynamic simulation. It will be more realistic if the force can be applied when the piston starts 

moving to the left (negative X-direction) and can be applied only for a selected short period. In order to 

do so, we will have to define measures that moni tor the posit ion of the piston for the firing load to be 

activated. Unfortunately, such a capability is not available in COSMOSMotion. Therefore, the force is 

simplified as a step function of 3 l b f along the negative X-direction applied for 0.1 seconds. The force will 

be defined as a point force at the center point of the end face of the piston, as shown in Figure 5-21. 

Before we add the force, we will turn off the angular velocity driver defined at the jo in t Revolute2 in 

the previous simulation. We will have to delete the simulation before we can make any changes to the 

F rom the browser, expand the Constraints branch, and then the Joints branch. Right click Revolute 

to bring up the Edit Mate-Defined Joint dialog box (Figure 5-22). Pul l -down the Motion Type and choose 

Free. Click Apply to accept the change. 

Note that if you run a simulation now, nothing will 

happen since there is no mot ion driver or force defined 

(gravity has been turned off). 

N o w we are ready to add the force. The force can 

be added from the browser by expanding the Forces 

branch, right clicking the Action Only node , and 

choosing Add Action-Only Force, as shown in Figure 5-

2 3 . In the Insert Action-Only Force dialog box, the 

Select Component to which Force is Applied field (see 

Figure 5-24) will be active (highlighted in red) and ready 

for you to pick the component . 

Pick the end face of the piston, as shown in Figure 

5-21. The part piston-1 is n o w listed in the Select 

Component to which Force is Applied field, and piston-

1/DDMFacelO is listed in both the Select Location and 

the Select Direction fields. That is, the force will be 

applied to the center of the end face and in the direction 

that is normal to the face; i.e., in the posit ive X-direction. 



N o w in the Insert Action-Only Force dialog box (Figure 5-24), the Select Reference Component to 

orient Force field is active (highlighted in red) and is ready for selection. We will p ick the bearing 

Initial Value: -3 

Final Value: 0 

Start Step Time: 0 

End Step Time: 0.1 

Note that the negat ive sign for the initial value is 

to reverse the force direction to the negative X-

direction. 

Click the graph button (right most , as shown 

in Figure 5-25), the step function will appear like 

the one in Figure 5-26. Note that this is a 

smoothed step function with t ime extrapolated to 

the negat ive domain. The force varies from -3 at 0 

second to 0 at 0.1 seconds. During the simulation, 

the force will be activated at the beginning; i.e., 0 

second. 

Close the graph and click Apply but ton to 

accept the force definition. You should see a force 

symbol added to the piston, as shown in Figure 5-4. 

Before running a simulation, we will increase 

the number of frames in order to see more refined 

results and graphs. F rom the browser, right click 

the Motion Model node, and choose Simulation 

Parameters. Change the number of frames to 500. 

Accept the change and then right click the Motion 

Model node , and choose Run Simulation. The 

mechan ism will m o v e and the crank will make 

several turns before reaching the end of the 

simulation duration; i.e., 1 second by default. 

Graphs created in previous simulation, such as the piston position, etc., should appear immediately at 

the end of the simulation. As shown in Figure 5-27, the piston moves along the.negat ive X-direction for 

about 0.15 seconds before reversing its direction. It is also evident in the velocity graph shown in Figure 

5-28 that the velocity changes signs at two instances (close to 0.15 and 0.48 seconds). Recall that the 

force was applied for the first 0.1 seconds. Had the force application lasted longer, the piston could be 

continuously pushed to the left (negative X-direction) even when the piston reaches the left end and tries 

to m o v e to the right (due to inertia). As a result, the crank would have been oscillating at the left of the 

center of the bearing; i.e., be tween 0 and 180 degrees about the Z-axis, wi thout making a complete turn. 

you should see As semi appear in the Select Reference Component to orient Force field. 

Click the Function tab (see Figure 5-25), choose Step for function, and enter the followings: 



Graph the reaction force for the applied force at the piston by expanding the Forces branch, then the 

Action Only branch, right clicking the ForceAO, and choosing Plot. The reaction force that represents the 

actual force applied to the piston appears, as shown in Figure 5-29. The graph shows that the force of 3 lbf 

was applied at the beginning of the simulation. The force gradually decreases to 0 in the 0.7-second 

period, which is wha t we expected and is consistent with the force function, as seen in Figure 5-26. 

Graph the reaction force at the jo in t Revolute (between crank and the ground) along the X-direction; 

you should see a graph like that of Figure 5-30. There are three peaks in Figure 5-30 representing when 

the largest reaction forces occur at the joint , which occurs at close to 0.15, 0.48, and 0.8 seconds; i.e., 

when the piston reverses its moving direction. The results make sense. 



5.4 Result Verifications 

In this section, we will verify the mot ion analysis results using kinematic analysis theory often found 

in mechanism design textbooks. No te that in kinematic analysis, position, velocity, and acceleration of 

given points or axes in the mechanism, are analyzed. 

In kinematic analysis, forces and torques are not involved. All bodies (or links) are assumed 

massless. Hence, mass properties defined for bodies are not influencing the analysis results. 

The slider-crank mechanism is a planar kinematic analysis problem. A vector plot that represents the 

posit ions of joints of the planar mechan ism is shown in Figure 5-31. The vector plot serves as the first 

step in comput ing position, velocity, and accelerations of the mechanism. 

The posit ion equations of the system 

can be described by the following vector 

summation, 

The real and imaginary parts of Eq. 5 .1 , corresponding to the X and / components of the vectors, can 
be writ ten as 

In Eqs. 5.2a and 5.2b, Zj, Z2, and 6 A are given. We are solving for Z 3 and 6B. Equations 5.2a and 

5.2b are non-linear. Solving them directly for Z s and 0 B is not straightforward. Instead, we will calculate 

Z 3 first, using tr igonometric relations; i.e., 



where two solutions ofZ3 represent the two possible configurations of the mechanism shown in Figure 5-

32. Note that point C can be either at C or C for any given Z 1 and 0A. 

Figure 5-32 Two Possible Configurations 

Similarly, 0 B has two possible solutions, corresponding to vector Z j . 

Taking derivatives of Eqs. 5.2a and 5.2b with respect to t ime, we have 





relatively. In Figure 3-37, the angular velocity 0 B is the angular velocity of the rod referring to the 

ground. Therefore, it is zero when the crank is in the upright position. 

Note that the accelerations of a given joint in the mechanism can be formulated by taking one more 

derivative of Eqs. 5.5a and 5.5b with respect to t ime. The resulting two coupled equations can be solved, 

using Excel spreadsheet. This is left as an exercise. 



Exercises: 

1. Derive the acceleration equations for the slider-crank mechanism, by taking derivatives of Eqs, 5.5a 

and 5.5b with respect to t ime. Solve these equations for the linear acceleration of the piston and the 

angular acceleration of the jo in t Revolute2, us ing a spreadsheet. Compare your solutions with those 

obtained from COSMOSMotion. 

2. Use the same slider-crank model to conduct a static analysis using COSMOSMotion. The static 

analysis in COSMOSMotion should give you equil ibrium configuration(s) of the mechanism due to 

gravity (turn on the gravity). Show the equil ibrium configuration(s) of the mechanism and use the 

energy method you learned from Sophomore Statics to verify the equilibrium configuration(s). 

3. Change the length of the crank from 3 to 5 in. in SolidWorks. Repeat the kinematic analysis 

discussed in this lesson. In addition, change the crank length in the spreadsheet {Microsoft Excel file, 

lesson5.xls). Generate posit ion and velocity graphs from both COSMOSMotion and the spreadshee: 

Do they agree with each other? Does the m a x i m u m slider velocity increase due to a longer crank? Is 

there any interference occurring in the mechanism? 

4. Download five SolidWorks parts from the publ isher ' s web site to your computer (folder name 

Exercise 5-4). 

(i) Use these five parts, i.e., bearing, crankshaft, connecting rod, piston pin, and piston (see Figure 

E5-1) , to create an assembly like the one shown in Figure E5-2. Note that the crankshaft m u s : 

orient at 45° C C W , as shown in Figure E5-2. 

(ii) Create a mot ion model for kinematic analysis. Conduct mot ion analysis by defining a d r i v a 

that drives the crankshaft at a constant angular speed of 1,000 rpm. 

Figure E5-1 Five SolidWorks Parts Figure E5-2 Assembled Configuration 





6.1 Overview of the Lesson 

In this lesson we will discuss h o w to simulate mot ion of a spur gear train. A gear train is a set or 

system of gears arranged to transfer torque or energy from one part of a mechanical system to another. A 

gear train consists of driving gears that are mounted on the input shaft, driven gears mounted on the 

output shaft, and idler gears that interpose between the driving and driven gears in order to maintain the 

direction of the output shaft to be the same as the input shaft or to increase the distance be tween the drive 

and driven gears. There are different kinds of gear trains, such as simple gear train, compound gear train, 

epicylic gear train, etc., depending on h o w the gears are shaped and arranged as well as the fuctions they 

intend to perform. The gear train we are simulating in this lesson is a compound gear train, in which two 

or more gears are used to transmit torque or energy. All gears included in this lesson are spur gears; 

therefore, the shafts that these gears mounted on are in parallel. 

In COSMOSMotion, gear pair is defined as a special coupler constraint. Joint couplers allow the 

mot ion of a revolute, cylindrical, or translational jo in t to be coupled to the mot ion of another revolute, 

cylindrical or translational joint . The two coupled joints m a y be of the same or different types. For 

example, a revolute jo in t m a y be coupled to a translational joint . The coupled motion m a y also be of the 

same or different type. For example, the rotary motion of a revolute jo in t may be coupled to the rotary 

mot ion of a cylindrical joint , or the translational mot ion of a translational jo int may be coupled to the 

rotary mot ion of a cylindrical joint . To create a gear pair, we will be coupling two revolute jo ints . Usually 

a concentric and a coincident mates will lead to a revolute joint , as seen in previous lessons. Coupl ing two 

revolute jo ints for a gear pair will be carried out in SolidWorks using the advance assembly mate option, 

where two axes that pass through the respective revolute jo ints (or gears) are picked for the gear mate. 

The gear mate will be mapped to a gear mate jo in t in COSMOSMotion. 

In fact, neither SolidWorks nor COSMOSMotion cares about the detailed geometry of the gear pair; 

i.e., i f the gear teeth mesh adequately. Y o u m a y simply uses cylinders or disks to represent the gears. No 

detailed tooth profile is necessary for any of the computat ions involved. Apparently, force and moment 

between a pair of teeth in contact will not be calculated in gear train simulations. However , there are other 

important data being calculated by COSMOSMotion, such as reaction force exerting on the driven shaft 

(for a dynamic analysis), which is critical for mechanism design. In any case, pitch circle diameters are 

essential for defining gear pair and gear trains in COSMOSMotion. Gear ratio of the gear train, which is 

defined by the ratio of the angular velocities of the output and input gears, is determined by the pitch 

circle diameters of the individual gear pairs in the gear train. 

Al though cylinders or disks are sufficient to model gears in SolidWorks, we will use more realistic 

gears throughout this lesson. All gears in the example are shown with detailed geometry, including teeth. 

In addition, detailed parts, including shafts, bearing, screws and aligning pins are included for a realistic 

gear train system, as shown in Figure 6-1 . In this gear train simulation, we will focus more on graphical 



animation, less on computat ions of physical quantities. We will add a mot ion driver to drive the input 
shaft. 

6.2 The Gear Train Example 

Physical Model 

The gear train example we are using for this lesson is part of a gearbox designed for an experimental 

lunar rover. The gear train is located in a gear box which is part of the transmission system of the rover, 

driven by a motor powered by solar energy. The purpose of the gear train is to convert a high-speed 

rotation and small torque generated by the motor to a low speed rotation and large torque output in order 

to drive the wheels of the rover. The gear train consists of four spur gears mounted on three parallel 

shafts, as shown in Figure 6 -1 . 

The four spur gears form two gear pairs: Pinion 1 and Gear 7, and Pinion 2 and Gear 2, as depicted 

in Figure 6-1 and 6-2. Note that Pinion 1 is the driving gear that connects to the mot ion driver; e.g., a 

motor. The motor rotates in a clockwise direction, therefore, driving Pinion 1. Gear 1 is the driven gear of 

the first gear pair, which is mounted on the same shaft as Pinion 2. Both rotate in a counterclockwise 

direction. Gear 2 is driven by Pinion 2, and rotates in a clockwise direction. Note that the diameters of the 

pitch circles of the four gears are: 50, 120, 60, and 125 m m , respectively; and the numbers of teeth are 25 , 

60, 24, and 50, respectively. Therefore, the circular pitch PC9 the diametral pitch Pd, and module m of the 

first gear pair are, respectively 



number of teeth of the four respective gears. The gear ratio of the gear train shown in Figure 1 is 1:5; i.e., 

the angular velocity is reduced 5 t imes at the output. Theoretically, the torque output will increase 5 t imes 

if there is no loss due to; e.g., friction. Note that we will use MMGS units system for this lesson. 

SolidWorks Parts and Assembly 

In this lesson, SolidWorks parts of the gear train have been created for you. There are six files 
created, gbox housing.SLDPRT, gbox input.SLDPRT, gboxjniddle.SLDPRT, gbox_output.SLDPRT, 

Lesson6.SLDASM, and Lesson6withresults.SLDASM. Y o u can find these files at the publ isher ' s web site 
(ht tp: / /www.schroff l .com/) . We will start wi th Lesson6.SLDASM, in which the gears are assembled to the 
housing. In addition, the assembly file Lesson6withresults.SLDASM consists of a complete simulation 
model with simulation results. 

Note that the housing part in SolidWorks was converted directly from Pro/ENGINEER part. The 

three gear parts in SolidWorks were converted from respective Pro/ENGINEER assemblies. There were 

nine, nine, and six distinct parts within the three gear assemblies, respectively. These three 

Pro/ENGINEER assemblies (and associated parts) were first converted to SolidWorks as assemblies. Parts 

in each assembly were then merged into a single gear part in SolidWorks. The detailed part and assembly 

conversions as well as merging multiple parts into a single part in SolidWorks can be found in Appendix 

C. 

In the SolidWorks assembly models Lesson6.SLDASM (and Lesson6withresults.SLDASM), there are 

nine assembly mates . The first three mates , Concentric1, Coincidentl, and Coincident2 assemble the 

input gear to the housing. The input gear is fully constrained. Note that before entering COSMOSMotion, 

we will suppress Coincident2 in order to al low rotational degree of freedom for the input gear about the 

Z-axis (see Figures 6-3a, b, and c). Similarly, the next three mates , Concentric2, Coincident^ and 

Coincident4 assemble the middle gear to the housing. Again, we will suppress Coincident4 to allow the 

middle gear to rotate about the Z-axis (see Figures 6-3d, e and f). The third set of mates , Concentric3, 

Coincident5, and Coincident6 does the same for the output gear (see Figures 6-3g, h and i). Similarly, 

Coincident6 will be suppressed to al low for rotation. Note that the three suppressed mates are created to 

properly orient the three gears, so that the gear teeth mesh well between pairs. 

http://www.schroffl.com/




As ment ioned earlier, one important factor for the animation to " look r ight" is to mesh the gear teeth 

properly. Y o u may want to use the Front v iew and zoom in to the tooth mesh areas to check if the two 

pairs of gears mesh well (see Figure 6-4). They should mesh well , which is accomplished by the three 

coincident mates that will be suppressed before entering COSMOSMotion. Note that the tooth profile is 

represented by straight lines, instead of more popular ones such as involutes, jus t for simplicity. 

Figure 6-4 Gear Teeth Properly Meshed 

If you turn on the axis display (View > Axes), axes that pass through the center of the gears about the 

Z-axis are defined for each gear. These axes are necessary for creating gear mates . 

Simulation Model 

The gear housing will be defined as the ground part. 

All three gears will rotate with respect to their respective 

axes. The four gears will be meshed into two gear pairs; 

Pinion 1 with Gear 7, and Pinion 2 wi th Gear 2, as 

discussed earlier. In SolidWorks, gear pairs are created by 

selecting two axes of respective gears (or cylinders) us ing 

Advanced Mates capability. Before the gear mates can be 

created, we will suppress the three coincident mates that 

help properly orient the gears; i.e., Coincident2, 

Coincident4 and Coincident6, in order to al low desired 

gear rotation motion. When these mates are suppressed, 

revolute joints will be created between the housing and the 

three gear parts in COSMOSMotion, as shown in Figure 6-

5. The revolute jo in t be tween the housing and the input 

gear will be driven at a constant angular velocity of 360 

degrees/sec. We will basically conduct a kinematic 

analysis for this example. 



6.3 Using COSMOSMotion 

Start SolidWorks and open the assembly file Lessond. SLDASM. 

Note that w h e n you open the assembly, you will see a message window, as shown in Figure 6-6, 

indicating that SolidWorks is unable to locate gbox input, sldasm. SolidWorks is t rying to locate the 

assembly from which the input gear part was created. Since the input gear assembly and its associated 

parts are not available in the Lesson 6 folder, SolidWorks is unable to locate it. It is fine to click No and 

not to locate gbox_input.sldasm. No t locating the assembly file for the input gear part will not affect the 

motion simulation in this lesson. After clicking No, SolidWorks will ask you to locate the middle gear 

assembly and output gear assembly. Choose No for both. The assembly files that SolidWorks is looking 

for are actually located in the subfolder under Lesson 6 as well as the Appendix C folder. You may 

choose Yes from the message window and locate the missing files in one of these two folders. 

Before entering COSMOSMotion there are 

two things need to be done. First, we will 

suppress three assembly mates , Coincident2, 

Coincident4 and Coincident6. Second, we will 

create two gear mates for the two gear pairs, 

respectively. 

F rom the Assembly browser, expand the 

Mates branch, right-click Coincident2, and 

choose Suppress. The mate Coincident2 will 

become inactive. Repeat the same to suppress 

Coincident4 and Coincident6. Save your model . 

Next , turn on the axis v iew by choosing 

from the pul l -down menu, View > Axes. All three 

axes, one for each gear, will appear in the 

graphics screen. 

We will create two gear mates . Choose f rom 

the pul l -down menu Insert > Mate. In the Mate 

dialog box (overlapping with the browser) , the 

Mate Selections field will be active (in red), and 

is ready for you to pick entities. Pick the axes of 

the input and middle gears from the graphics 

screen. Choose Advanced Mates, click Gear, and 

enter 50mm and 120mm for Ratio, as shown in 

Figure 6-7. Click the checkmark button on top to 

accept the mate definition, and click the same 

but ton one more t ime to close the dialog box. 

Note that if the axes of the two gears are pointing in the opposite direction, you will have to click 

Reverse (right be low the Ratio text field in the Mate dialog box) to correct the rotation direction. In this 

example, all three axes are pointing in the same direction. Therefore, do not choose Reverse. 

Repeat the same steps to define the second gear mate. This t ime, pick the axes of the middle and 

output gears, and enter 60mm and 125mm for Ratio. Two new mates , Gear Mate 1 (gbox_input<l>, 

gbox_middle<l>) and GearMate2(gbox_middle<l>,gbox_output<l>), are n o w listed under Mates. 



N o w we are ready to enter COSMOSMotion. 

Click the Motion button # enter COSMOSMotion. 

Similar to previous lessons, we will use the browser, and basic drag-and-drop and right-clicl^ 
methods to create and simulate the gear train motion in this lesson. 

Before creating any entities, a lways check the units system. Make sure the units system chosen is 

MMGS. Defining Bodies 

From the browser, expand the Assembly 

Components branch. Y o u should see four parts 

listed, gbox housing-1, gboxjnput-l, gboxmiddle-

1, and gbox_output-l, as shown in Figure 6-8. 

Also expand the Parts branch; you should see 

Moving Parts and Ground Parts listed. Go ahead to 

m o v e gboxjiousing-l to Ground Parts and move 

the three gears to Moving Parts by using the drag-

and-drop method. 

Expand the Constraints branch, and then the Joints branch. You 

should see two gear mates and three revolute joints listed, as shown in 

Figure 6-9. In addition, you should see the revolute jo in t symbols appear in 

the graphics screen, similar to those of Figure 6-5. Expand all joints in the 

browser and identify the parts they connect. Take a look at the joint 

Revolute2 (connecting the input gear to the gear housing) , where we will 

add a driver next. No te that you m a y see a different revolute jo in t 

connecting the input gear to the gear housing. Make sure you pick the right 

one. 

Driving Joint 

From the browser , expand the Constraints node and 

then the Joints node . Right-click the Revolute2 node and 

choose Properties. In the Edit Mate-Defined Joint dialog 

box (Figure 6-10), under the Motion tab (default), choose 

Rotate Z for Motion On, choose Velocity for Motion Type, 

choose Constant for Function, and enter 360 degrees/sec for 

Angular Velocity (should appear as defaults). Click Apply to 

accept the definition. A mot ion driver symbol should appear 

at Revolute2, as shown in Figure 6-5. 

We are ready to run a simulation. We will use all 
default simulation parameters . 

N o w we are ready to enter COSMOSMotion. 

enter COSMOSMotion. Click the Motion but ton 



Running Simulation 

Click the Motion Model node , press the right mouse button and select Run Simulation. After a few 

seconds, you should see the gears start turning. The input gear rotates 360 degrees as expected since the 

default simulation duration is 7 second. 

Saving and Reviewing Results 

We will graph the angular velocity of the output gear. 

F rom the browser, expand the Parts branch and then the Moving Parts branch. Right-click the 

ghox_output-l node, and choose Plot > Angular Velocity > Z Component (Figure 6-11). The graph 

should appear and is similar to that of Figure 6-12, which shows that the output velocity is a constant of 

72 degrees/sec. Note that this magni tude is one fifth of the input velocity since the gear ratio is 7:5. Both 

the input (Pinion 7) and output gears (Gear 2) rotate in the same direction. COSMOSMotion gives good 

results. 

Save your model . 



Exercises: 

1. The same gear train will be used for this exercise. Create a constant torque for the input gear 

(gboxinput.SLDPRT) about the Z-axis. Turn on friction for all three axles (Steel-Dry/Steel-Dry). 

Define and run a 2-second dynamic simulation for the gear train. 

(i) What is the min imum torque that is required to rotate the input gear, and therefore, the entire 

gear train? 

(ii) If the torque applied to the input gear is 100 mm N, what is the output angular velocity of the 

gear train at the end of the 2-second simulation? Verify the simulation result using your own 

calculation. 

(iii) Create a graph for the reaction moment be tween gears of the first gear pair {GearMatel) due to 

the 100 mm N torque. What is the reaction m o m e n t obtained from simulation? 





7.1 Overview of the Lesson 

In this lesson, we will learn cam and follower, or cam-follower. A cam-follower is a device for 

converting rotary mot ion into linear motion. The simplest form of a cam is a rotating disc wi th a variable 

radius, so that its profile is not circular but oval or egg-shaped. W h e n the disc rotates, its edge (or side 

face) pushes against a follower (or cam follower), which m a y be a small wheel at the end of a lever or the 

end of the lever or rod itself. The follower will thus rise and fall at exactly the same amount as the 

variation in radius. By profiling a cam appropriately, a desired cyclic pattern of straight-line motion, in 

terms of position, velocity, and acceleration, can be produced. 

The camshaft and the rocker will rotate about the axes of their respective revolute jo ints connecting 

them to their respective bearings (defined as ground body) . The camshaft is driven by a motor of constant 

velocity of 600 r pm (or 10 rev/sec). The profile of the cam consists of two circular arcs of 0.25 and 0.5 in. 

radii, respectively, as shown in Figure 7-2. The lower arc is concentric with the shaft, and the center of 

the upper arc is 0.52 in. above the center of the shaft. W h e n the camshaft rotates, the cam mounted on the 

shaft pushes the pushrod up by up to 0.27 in. (that is, 0.52+0.25-0.5 = 0.27). As a result, the rocker will 

rotate and push the valve at the other end downward at a frequency of 10 t imes/sec. The valve will move 

again up to 0.27 in. downward since the pushrod and the valve are posi t ioned at an equal distance from 

the rotation axis of the rocker. When the camshaft rotates where the larger circular arc (0.5 in. radius) of 

We will learn to create a mot ion mode l and simulate 

the control of opening and closing of an inlet or exhaustive 

valve, usual ly found in internal combust ion engines, using 

cam-follower connections. In a design such as that of 

Figure 7 -1 , the drive for the camshaft is taken from the 

crankshaft through a t iming chain, which keeps the cams 

synchronized with the movement of the piston so that the 

valves are opened or closed at a precise instant. The 

mechanism we will be working with consists of bushings, 

camshaft, pushrod, rocker, valve, valve guide and spring, 

as shown in Figure 7 -1 . The cam-follower connects the 

camshaft and the pushrod. When the cam on the camshaft 

pushes the pushrod up , the rocker rotates and pushes the 

valve on the other side downward. The spring surrounding 

the valve gets compressed, and opens up the inlet for air to 

f low into the combust ion chamber. 

7.2 The C a m and Fol lower Example 

Physical Model 



the cam is in contact with the follower (in this example, the pushrod) , the pushrod has room to m o v e 
downward. At this point, the rocker will rotate back since the spring is being uncompressed. As a result, 
the valve will move up, and therefore, close the inlet. The valve will be open for about 120 degree per 
cycle, based on the cam design shown in Figure 7-2. 

The unit system chosen for this example is IPS and all 

parts are made up of steel. 

SolidWorks Parts and Assembly 

The cam-follower system consists of seven parts, bushing 

(two), valve guide, camshaft, pushrod, rocker, and valve, as 

shown in Figure 7 -1 . In addition, there are two assembly files, 

Lesson7.SLDASM and Lesson7withresults.SLDASM that you 

m a y download f rom the publ isher ' s w e b site. 

We will start with Lesson 7. SLDASM, in which the parts are adequately assembled. In this assembly 

the first bushing is anchored (ground) and the second busing and the valve guide are fully constrained. 

These three parts will be assigned as ground parts. The remaining four parts will be defined as movable 

parts in COSMOSMotion. 

Same as before, the assembly file 

Lesson 7withresults. SLDASM contains a complete 

simulation model with simulation results. You may want 

to open the assembly to see the mot ion animation of the 

mechanism. In the assembly where a mot ion model is 

completely defined, a mate has been suppressed to al low 

movemen t between components . You can also see h o w 

the parts move by right clicking in the graphics screen, 

choosing Move Component, and dragging any movable 

parts; for example the camshaft to rotate with respect to 

the second bushing. The whole mechanism will move 

accordingly. 

There are eighteen assembly mates , including four 

coincident, three concentric, seven distance, two parallel, 

one tangent, and one cam-mate-tangent , as listed in the 

browser (see Figure 7-3). Y o u m a y want to expand the 

Mates branch in the browser to review the list of 

assembly mates . M o v e the cursor over any of the mates ; 

you should see the entities selected for the assembly 

mate highlighted in the graphics screen. 

As ment ioned earlier, the first bushing, 

bushing<l>, shown in the browser is anchored to the 

assembly. The second bushing (bushing<2>) and the 

valve guide (valve guide<l>) were fully assembled to 

bushing<l>. The first three mates , Coincident 1, 

Distance 1, and Distance2, were employed to assemble 

bushing<2> to bushing<l>. A n d the next three distance 

mates assemble the valve guide to bushing<l>. 



Note that the distance mates are essentially coincident mate with distance be tween entities. The 

distance mates were created to properly posit ion the second bushing with respect to the first bushing. All 

three parts will be defined as the ground part in COSMOSMotion. 

The next two mates , Concentric 1 and Coincident!, assemble the rocker {rocker<l>) to the first 

bushing (hushing<l>), al lowing a rotation degree of freedom about the Z-axis, as shown in Figures 7-4a 

and b. COSMOSMotion will map a revolute jo in t be tween the rocker and the first bushing. 

The next part assembled is the pushrod (pushrod<l>). The pushrod was assembled to the rocker 

using Tangent/, Distance6, and Coincident3 mates , as shown in Figures 7-4c, d, and e, respectively. As a 

result, the pushrod is a l lowed to m o v e vertically at a distance of 1.25 in. from the Right plane of the first 

bushing (Distanced), at the same t ime, maintaining tangency between the top of the cylindrical surface of 

the pushrod and the socket surface of the rocker. 

(c) Pushrod: Tangent l (d) Pushrod: Distance6 (e) Pushrod: Coincident3 

Figure 7-4 Assembly Mates Defined for the Mechan i sm 



The next part is the camshaft (cam_shaft<l>). The camshaft was first assembled to the second 

bushing (bushing<2>), and then to the pushrod. Concentric2 aligns the camshaft and the second bushing. 

Coincident4 mates the center plane of the camshaft to that of pushrod, as shown in Figures 7-4f and g. As 

a result, the camshaft is al lowed to rotate about the Z-axis. 

In addition, the CamMateTangentl defines a cam and follower between the cam surface of the 

camshaft and the cylindrical surface at the bot tom of the pushrod. Note that all surrounding surfaces on 

the cam and follower must be selected for the cam-follower joint . In this case, four surfaces are selected 

for the cam (mounted on the camshaft) and one surface is included on the follower, as shown in Figure 7-

4h. Note that the assembly should have overall one degree of freedom at this point. Y o u m a y either rotate 

the camshaft, the rocker, or move the pushrod vertically to see the relative mot ion of the assembly. Use 



Apparently, this result implies that there are redundant 

d o f s created in the system. This is fine since 

COSMOSMotion filters out the redundant d o f s . Y o u m a y 

want to check the redundancy by choosing, f rom the pull­

down menu, COSMOSMotion > Show Simulation Panel, as 

discussed in Appendix A. You m a y want to review 

Appendix A for more information about defining joints and 

calculating degrees of freedom. 

The final mot ion model is shown in Figure 7-6, where the Z-rotation of the concentric joint, 

Concentric2, be tween the camshaft and the second bushing is driven by a constant angular velocity of 



3,600 degrees/sec; i.e., 600 rpm, about the Z-axis of the global coordinate system. In addition, a spring 

surrounding the valve will be created in order to provide a vertical force to push the rocker up, therefore, 

close the valve. The spring has a spring constant of 10 lbf/in and an unstretched length of 1.25 in. The 

spring is created between the bot tom face of the rocker and top face of the valve guide. 

7.3 Using COSMOSMotion 

Start SolidWorks and open assembly file Lesson 7. SLDASM. 

Again, always check the units system. Make sure that IPS units system is chosen for this example. 

Defining Bodies 

From the browser, expand the Assembly Components branch. You should see seven entities listed, 

Bushing-1, Bushing-2, cam_shaft-1, pushrod-1, rocker-7, valve guide-1, and valve-1, as shown in Figure 

7-7. Also expand the Parts branch; you should see Moving Parts and Ground Parts listed. We will move 

Bushing-1, Bushing-2, and valve guide-1 to Ground Parts and the remaining four parts to Moving Parts 

by using the drag-and-drop method. 

F rom the browser, click Bushing-1. Press the Ctrl key and click Bushing-2 and valve guide-1. All 

three parts should be selected. Drag and drop them to the Ground Parts node. 

Repeat the same to select the remaining four parts under the Assembly Component branch. Drag and 
drop them to the Moving Parts node. 

Expand the Constraints branch, and then the Joints branch. You should see that ten joints are listed 

(see Figure 7-5). All joint symbols should appear in the graphics screen, similar to that of Figure 7-6. 

Expand all joints in the browser and identify the parts they connect. Take a look at the jo in t Coincident2 

(connecting camshaft to Bushing-2), where we will add a driver next. 

F rom the browser, click the Motion button if 1 to enter COSMOSMotion. 



Driving Joint 

Right click the Concentric2 node and choose Properties (see Figure 7-8). In the Edit Mate-Defined 

Joint dialog box (Figure 7-9), under the Motion tab (default), choose Rotate Z for Motion On, choose 

Velocity for Motion Type, choose Constant for Function, and enter 3600 degrees/sec for Angular Velocity, 

as shown in Figure 7-9. Click Apply to accept the definition. 

Defining Spring 

From the browser, expand the Forces branch, right click the Spring node and choose Add 

Translational Spring (see Figure 7-10). In the Input Spring dialog box (Figure 7-11), the Select 1st 

Component field should be highlighted in red and ready for you to pick. Rotate the v iew and pick the 

bot tom face of the rocker (see Figure 7-12), the Select 2nd Component field should n o w highlight in red, 

and rocker-1/DDMFace 19 should appear in the Select Point on 1st Component field, which indicates that 

the spring will be connected to the center point of the face selected. 

In case you picked a wrong entity, simply select the 

entire text in the respective text field in the dialog box, and 

press the Delete key to delete the text. The text field will turn 

back to red and will be ready for you to pick another entity. 

Rotate the v iew back, and then pick the top face in the 

valve guide, as shown in Figure 7-12. N o w , valve guide-1 

and valve guide-l/DDMFace20 should appear in the Select 

2nd Component field and Select Point on 2nd Component 

field, respectively. Also, a spring should appear in the 

graphics screen, connecting the center points of the two 

faces. 

Enter the followings: 

Stiffness: 10 

Length: 1.25 (Note that you have to deselect the Design box 

to the right before entering this value) 

Force: 0 

Coil Diameter: 0.75 

Number of coils: 8 

Wire Diameter: 0.1 

Click Apply to accept the spring definition and close the 

Insert Spring dialog box. 

Defining and Running Simulation 

Click the Motion Model node, press the right mouse 

button and select Simulation Parameters. Enter 0.5 for 

simulation duration and 500 for the number of frames. 

Click the Motion Model node again, press the right mouse button and select Run Simulation. You 

should see that the camshaft starts rotating, the pushrod is moving up and down, which drives the rocker, 



and then the valve. The camshaft rotates 5 t imes in the 0.5-second simulation duration. We will graph the 
position, velocity, and acceleration of the valve next. 

Graph the 7-velocity and 7-acceleration of the valve by choosing Plot > CM Velocity (and CM 

Acceleration) > Y Component. The graphs of the velocity and acceleration are shown in Figures 7-15 and 

16, respectively. As shown in Figure 7-15, there are two velocity spikes per cycle, representing that the 

valve is pushed downward (negative velocity) for opening and is being pulled back (positive velocity) for 

closing, respectively. The valve stays closed with zero velocity. 

Figure 7-16 reveals h igh accelerations when the valve is pushed and pulled. Note that such a high 

acceleration is due to high-speed rotation at the camshaft. This high acceleration could produce large 

inertial force on the valve, yielding high contact force between the top of the valve and the socket surface 

in the rocker. We would like to check the reaction force between the top of the valve and the rocker. The 

As shown in Figure 7-14, the flat port ion 

on top indicates that the valve stays 

completely closed, which spans about 0.066 

seconds, approximately 240 degrees of the 

camshaft rotation in a complete cycle. 

Therefore, the valve will open for about 0.034 

seconds per cycle, roughly 120 degrees. 



graph of the reaction force can be created by expanding Constraints and Joints branches, right clicking 

Concentric2 (between the valve and the rocker) , and choosing Plot > Reaction Force > Y Component. 

The reaction force graph (Figure 7-17) shows that the reaction force be tween the top of the valve and 

the socket face of the rocker is about 0.4 l b f , which is insignificant. Note that this small reaction force can 

be attributed to the small mass of the valve. If you open the valve part and acquire its mass (from pull­

down menu , choose Tools > Mass Properties), the mass of the valve is 0.03 l b m . Therefore, the inertia for 

the valve at the peak accelerations is about 0.03 \bmx5,600 in /sec 2 = 168 l b m in /sec 2 = 168/386 l b f = 0.44 

lbf, which is consistent to peaks found in Figure 7-17. If you are not quite sure about w h y this 386 is 

factored in for force calculation, please refer to Appendix B for mass and force unit conversions. Save 

your model . 



Exercises: 

1. Redesign the cam by reducing the small arc radius from 0.25 to 0.2 and reducing the center distance 

of the small arc from 0.52 to 0.40, as shown in Figure E 7 - 1 . Repeat the dynamic analysis and check 

reaction force be tween the valve and the rocker. Does this redesigned cam alter the reaction force? 

2. If we change the Parallel! mate be tween the Right plane of the valve and the Right plane of the first 

bushing to a distance mate , will the mechanism move? What other changes must be made in order to 

create a val id and movable mechanism similar to that was presented in this lesson? 



8.1 Overview of the Lesson 

This is an application lesson. We will apply what we learned in previous lessons to a real-world 

application. This application involves designing a device that can be mounted on a wheelchair to mimic 

soccer ball-kicking action whi le being operated by a child sitting on the wheelchair with l imited mobili ty 

and hand strength. Such a device will provide more incentive and realistic experience for children with 

physical disabilities to participate in soccer games. This example was extracted from an undergraduate 

student design project that was carried out in conjunction with a local children hospital. This device was 

intended primarily to be used in the summer camp sponsored by the children hospital. 

The focus of this lesson is slightly different from previous ones. Instead of focusing on discussing 

h o w to use COSMOSMotion to create mot ion entities, we will focus on h o w to use COSMOSMotion to 

support design. In order to nar row down the design options to be more manageable , we will assume all 

major components are designed wi th dimensions determined. More specifically, we will use 

COSMOSMotion to help choose a spring, as well as determine if the required operating force is 

acceptable. Since the users of this device are children with l imited physical hand strength, the operating 

force must be minimized in order to make the device useful. 

The examples we have discussed in previous lessons are simple enough so that some of the 

simulation results can be verified by hand calculations (for example, using a spreadsheet). However , most 

of the real-world applications, including the example of this lesson, are too complicate to verify by hand 

calculations. When we are dealing wi th such applications, two principles are helpful in leading to 

successful simulations. First, the simulation model you created has to be physically meaningful and is as 

consistent to the physical conditions as possible. Second, very often you will have to make assumptions in 

order to simplify the problems so that the simulations can be carried out. This is because that the 

simulation models must comply wi th the ability of the software you are using. In order to effectively use 

the simulations to support design, you will have to unders tand the physical problems very well ; in the 

mean t ime, be familiar with the capabilities and limitations of the software you are using. 

Since most of you will be often learning the software as you are tackling simulation and/or design 

problems, i t is strongly recommended that you employ the principle of spiral development to 

incrementally bui ld up your simulation model . In another word, you m a y want to start from a simplified 

model with simple scenarios by making adequate assumptions to your simulation model . Make the 

simplified model works f i rs t , then relax the assumptions and add mot ion entities to make your model 

closer to the real situation. Repeat the process until you reach a simulation model and simulation 

scenarios that answer you questions and help you make design decisions. In each step, make sure that the 

simulation model does what you expect i t to do before bringing it to the next level. 

In this lesson, we will employ the spiral development principle. We will assume that all components 

and their physical dimensions are determined. The design is essentially nar rowed down to the selection of 



a spring, including both spring constant and free length, and to ensure that the required force is small 

enough for a child to easily operate the device. We will try our best to check and hopefully verify the 

simulation model in each step. Note that COSMOSMotion is very sensitive to some of the conditions and 

parameters , such as the initial condition (that is, the handle bar orientation), spring constant, etc. Some of 

the conditions simulated are physically meaningful and yet COSMOSMotion gives unrealistic simulation 

results due to its limitations. Again, COSMOSMotion is not foolproof. One cannot blindly accept the 

simulation results. When a result is determined unrealistic after reviewing animation, graphs, etc., the best 

way to proceed is to compose a simpler simulation model and/or try a different (more idealized) scenario 

until the simulation result is physically meaningful based on your educated judgment . You will see trials-

and-errors in this lesson and many other real-world applications in the future. 

8.2 The Assist ive Device 

Physical Model 

This assistive device for soccer games consists of five major components : the clamper, handle bar, 

plate, kicking-rod, and spring, as illustrated in Figure 8-1. In reality these five components will be 

assembled first and c lamped to the lower frame of the wheelchair for use. 

The handle bar is mounted to the plate at the pivot pin of the plate and linked to the middle pin of the 

kicking rod. The kicking rod is inserted into the two lower brackets mounted on the plate. When the 

handle (on top of the handle bar) is pulled backward, the handle bar rotates about the pivot pin; therefore, 

drives the kicking rod to m o v e forward along the longitudinal direction through the link between the 

bot tom slot of the handle bar and the middle pin of the kicking rod. The forward movement of the kicking 

rod produces momen tum to "kick" the soccer ball. A spring is added between the upper bracket and the 

handle bar to restore the handle bar to its neutral posit ion after pulling. The spring also helps the user to 

pull the handle bar with a lesser force. 



The focus of this lesson is to use COSMOSMotion to simulate the posit ion and velocity of the 

kicking rod for a given force that can be comfortably provided by a child with l imited physical strength. 

Lots of factors contribute to the operating force of the mechanism. For example, one of the critical 

parameters is the location of the pivot pin. The lower the pivot pin is located the lesser force is required to 

operate the mechanism. However , the purpose of this lesson is not necessarily to determine the final 

design of the device, but illustrate the process of using COSMOSMotion to assist the design. Therefore, as 

ment ioned earlier, the scope of the design has been narrowed down to the selection of the spring and to 

determine if the force is small enough for a child to operate the device. 

SolidWorks Parts and Assembly 

The assembly of the mechanism consists of eight parts and one subassembly. These parts are 

handle.SLDPRT, plate. SLDPRT, rod.SLDPRT, foot.SLDPRT, clamper. SLDPRT, joint.SLDPRT, 

collar. SLDPRT, and wheelchair.SLDPRT. The subassembly is kickingjrod.SLDASM which consists of 

rod.SLDPRT m& foot.SLDPRT. 

In addition, there are six assembly files, Lesson8. SLDASM, Lesson8TaskOne.SLDASM, 

Lesson8TaskTwo.SLDASM, Lesson8TaskThreeNoFriction.SLDASM, Lesson8TaskThreeSmallFriction. 

SLDASM, mdLesson8TaskThreeLargeFriction. SLDASM. You can download these files from publ isher ' s 

web site. 

Same as before, the assembly fi les, with the exception of 

Lesson8.SLDASM, consist of complete simulation models with 

simulation results under respective simulation scenarios. Y o u 

may want to open these f i les to see the motion animations of 

the mechanism. In these assembly files, a mate (Anglel) has 

been suppressed. Y o u can also see h o w the parts m o v e by right 

clicking in the graphics screen, choosing Move Component, 

and dragging any movable parts; for example dragging the 

handle to drive the kicking rod. 

There are fifteen assembly mates , including four 

coincident, three concentric, four distance, two parallel, and 

one angle, defined in the assembly, as listed in the browser 

(see Figure 8-2). Y o u m a y want to expand the Mates branch in 

the browser to see these assembly mates . M o v e your cursor 

over any of the mates ; you should see the entities chosen for 

the assembly mate highlighted in the graphics screen. 

The f irs t nine mates assemble the clamper to the 

wheelchair , the jo in t to the clamper and the wheelchair , and 

then the plate to the joint part. Note that the jo in t is a 

SolidWork part that connects the plate and the c lamper rigidly. 

These nine mates are pretty standard. All these parts are fully 

constrained and are fixed to the wheelchair . 

The next two mates , Concentric3 and Distance4, assemble the handle bar to the plate at the pivot 

pin, al lowing the handle bar to rotate at the pivot pin, as shown in Figure 8-3a. COSMOSMotion will 

convert these mates to a revolute joint . The distance mate provides an adequate clearance between the 

handle bar and the plate, as shown in Figure 8-3b. 





The next three mates , CamMateTangentl, Coincident3, and Coincident4, assemble the kicking rod 

to the plate and the handle bar. First, the middle pin of the kicking rod is assembled to the inner surface of 

the bot tom slot of the handle bar using CamMateTangentl, as shown in Figure 8-3c. As a result, the pin 

can only m o v e within the slot, which is desirable. Second Coincident3 mates the bot tom face of the 

kicking rod to the inner bot tom face of the first lower bracket of the plate, as shown in Figure 8-3d. 

Similarly Coincident4 mates the rear face of the kicking rod to the inner side face of the first lower 

bracket of the plate, as shown in Figure 8-3e. These two mates restrict the kicking rod to slide along the 

longitudinal direction, which will be converted to a translational jo in t by COSMOSMotion. 

The final mate , Anglel, orients the vertical plane of the handle bar {Right Plane) respect to that of 

the plate {Right Plane). This mate will help determine an initial condition for mot ion simulations. Note 

that the Anglel mate to orient the handle, i t will has to be suppressed to allow the handle bar to rotate 



Based on the geometry of the mechanism and dimensions of its constituent components , the kicking 

rod is able to travel a total of 12.2 in. along the longitudinal direction (Z-direction). The kicking rod can 

move 6.82 in. forward (positive Z-direction with respect tot the middle pin) until its middle pin becomes 

in contact with the inner face at the lower end of the slot, as shown in Figure 8-4a. Similarly, the kicking 

rod moves 5.34 in. backward until the side face of the handle bar becomes in contact wi th the front end 

face of the first lower bracket, as shown in Figure 8-4b. 

At the same t ime, the handle will travel a total of 18.6 in., 9.98 backward and 8.6 in. forward, as 

shown in Figures 8-4c and 8-4d, respectively. Note that these measurements shown in Figure 8-4 can be 

obtained by using the Measure option in SolidWorks. To access the Measure option, simply choose from 

the pul l -down m e n u Tools > Measure. 

Simulation Model 

In this mot ion model , the only moving parts are the handle bar and the kicking rod. After 

suppressing the mate Angle1, COSMOSMotion will add a revolute jo in t to the mot ion model between the 

handle bar and the plate at the pivot pin, as shown in Figure 8-5. The handle bar is al lowed to rotate about 

the X-axis of the global coordinate system at the pivot pin. In addition, a translational jo in t is created by 

COSMOSMotion be tween the kicking rod and the first lower bracket. This jo in t constrains the kicking rod 

to translate along the longitudinal direction; i.e., the Z-direction. The third and final jo in t is the 

CamMateTangent be tween the outer surface of the middle pin and the inner surface of the slot at the 

bot tom of the handle bar. This jo in t restricts the pin to move inside the slot. 

In addition to joints , a spring is added between the 

upper bracket of the plate and the hook on the side of the 

handle bar. This spring, as shown in Figure 8-5, is added 

to restore the handle bar to a neutral posit ion after 

pull ing. Since the free spring length is set to a slightly 

larger value so that the handle bar will be oriented at a 

negative 5~/0-degree angle (about the X-axis). 

Therefore, the user will have to push the handle forward 

before pulling it back to kick the ball. A larger spring 

free length will push the handle leaning further 

backward (toward the user) , providing additional pull ing 

force that helps the users to pull back the handle bar. 

Note that the pull ing action will push the kicking rod 

forward (positive Z-direction) to "kick" the soccer ball . 

There is one contact constraint added to the mot ion 

model . The contact constraint is defined between the 

outer side face of the handle bar and the front end face of 

the first lower bracket. This contact constraint will 

prevent the handle bar from moving further backward 

and penetrating through the brackets. In this contact 

constraint, a restitution coefficient of 0.5 is assumed. 

Finally, an impulse force of 5-65 l b f in a t ime span of 1.0 second will be added to the handle bar 

along the Z-direction, as shown in Figure 8-5, to simulate the operating force. Note that the impulse force 

must first push the handle bar about 10 degrees forward before pull ing it back, as illustrated in Figure 8-6. 



In this example, we will turn on the gravity, which is acting in the negat ive 7-direction (vertically 

downward) ; i.e., the default setting. We will first assume no friction in any joints . This assumption will 

greatly simplify the simulation model and help set up the mot ion model correctly. We will use this model 

to choose a spring, including the selection of spring constant and free length. The simulation results of 

this non-friction model have been created in the assembly files Lesson8TaskOne.SLDASM and 

Lesson8TaskTwo. SLDASM. 

The frict ion force will be turned on for both the revolute and translational joints to determine the 

required force for operating the mechanism. In addition, the operating force, mode led as an impulse force 

will be added to the mechanism. Note that the friction is not added to the CamMateTangent jo in t between 

the middle pin and the slot since such a capability is not currently supported by COSMOSMotion. Results 

of these simulations can be found in Lesson8TaskThreeNoFriction.SLDASM, 

Lesson8TaskThreeSmallFriction.SLDASM, and Lesson8TaskThreeLargeFriction.SLDASM. 

8.3 Us ing COSMOSMotion 

In this example, we will start wi th a valid simulation model defined in the assembly 

Lesson8.SLDASM. The unit system is IPS. When you open this assembly file, you should see a properly 

assembled model with fifteen mates , as shown in Figure 8-2, where the last constraint, Angle1, should 

have been suppressed. No te that the mate angle is set to posit ive 10 degrees for the t ime being, and the 

handle bar is leaning forward ( toward the Z-direction), as shown in Figure 8-7. Note that this angle is 

what we assume for Task One simulations. 

If you enter COSMOSMotion and expand the Parts and Constraints branches in the browser, you 

should see the existing mot ion entities, as shown in Figure 8-8. There are four parts under the Ground 

Parts branch. Only handle bar and kicking rod are movable . In addition, there are three jo ints defined, 

CamMateTangentl, Revolute, and Translational, as discussed earlier. In the Contact branch under the 

Constraints, there is one contact joint , Contact 3D, defined to prevent the kicking rod from penetrating 

into the brackets . Due to the contact constraint and the restitution coefficient defined, the handle bar will 

bounce back when it hits the front edge of the first lower bracket. 



There are three major tasks we will carry out in this design. In Task One we will run simulation to 

check the function of the 3D contact constraint. We hope to ensure that all joints are adequately defined, 

and the restitution coefficient we assumed in the contact constraint gives us reasonable results. 

In Task Two, we will add the spring. We will adjust the spring constant and its free length until we 

reach an equilibrium configuration that we can work with. No te that a desired free length should bring the 

handle bar backward a negative 5-10 degree angle ( a b o u t the X-axis). After the spring is determined, we 

will add an operating force at the handle in Task Three. Note that the force will first push the handle bar 

forward about 10 degrees (positive, a b o u t the X-axis) before pull ing it backward in order to provide 

enough travel distance for the kicking rod, and hopefully, sufficient m o m e n t u m to kick the ball. 

In Task Three, we will start with a non-friction case, and then turn on friction in both the revolute 

and translational joints . F rom the friction cases, we will determine if the operating force is sufficient to 

push the handle forward about 10 degrees before pull ing it backward. We will vary the friction 

coefficients to simulate different scenarios and then determine the magni tude of the operating forces 

accordingly. The magni tude of the force will answer the critical question: if the design is acceptable. We 

hope to keep the m a x i m u m force magni tude under 20 lbf. 

Task One: Determining Contact Constraints 

We will carry out simulations for the mot ion model defined in Lesson8.SLDASM. In the assembly, 

the handle is leaning forward 10 degrees (see Figure 8-7), the contact jo in t Contact 3D is defined, and the 

gravity is turned on. You m a y want to open the Contact3D constraint by right clicking Contact3D from 

the browser and choosing Properties. In the Edit 3D Contact dialog box, you should see that the plate and 

handle are included in the first and second containers, respectively, as shown in Figure 8-9. If you choose 

the Contact tab, you should see that the Coefficient of Restitution is 0.5, as shown in Figure 8-10. Note 

that no friction is imposed for this constraint. Close the dialog box by clicking the Apply button. 



Also, we would like to make sure that the gravity is set up properly. F rom the browser, r ight click 

the Motion Model node and select System Defaults. In the Options dialog box (Figure 8-11), you should 

see the acceleration is 386.22 in /sec 2 , and the Direction is set to -1 for Y. Click OK to accept the gravity 

setting. 

Click the Motion Model node from the browser, press the right mouse button and select Simulation 

Parameters. Enter 2 for simulation duration and the 200 for the number of frames, as shown in Figure 8-



12. M a k e sure the Use Precise Geometry for 3D Contacts is selected in order for COSMOSMotion to 
detect contact during simulation. 

Click the Motion Model node again, press the right mouse button and select Run Simulation. You 

should see that the handle bar start moving forward and the kicking rod moving backward due to gravity. 

When the handle bar and the first lower bracket is in contact, the handle bar bounces back slightly due to 

the contact constraint we defined. 

Next , we will graph the posit ion and velocity of the kicking rod a l o n g the Z-direction. 

F rom the browser, expand the Parts node and then the Moving Parts node . Right click kickingjrod-

7, and choose Plot > CM Position > Z, and Plot > CM Velocity > Z Component. 

Two graphs like those of Figures 8-13 and 8-14 should appear. No te that the vertical scales of the 

graphs have been adjusted for clarity. The position graph shows that the mass center of the kicking rod 

was located at Z = 21.6 in. initially. The mass center moves to the right to Z = 17.8 in., where the handle 

bar is in contact with the first lower bracket. The handle bar, therefore the kicking rod, bounces back, and 

the center mass of the kicking rod reaches to Z = 18.6 in. before it slides to the right again due to gravity. 

After about 1.5 seconds, the kicking rod rests and stays in contact with the bracket. 

The velocity graph (Figure 8-14) shows that the bouncing velocity is half of the incoming velocity in 

the opposite direction. This is certainly due to the 0.5 restitution coefficient defined at the contact 

constraint. 

F rom these two graphs, we conclude that the mot ion model has been defined correctly. Save your 

model . You m a y want to save the model under different name and use i t for Task T w o simulations. 

Task Two: Adding Spring 

In Task Two, we will add a spring to the mechanism. We will adjust the spring constant and its free 

length until we reach an equil ibrium configuration that we can work with. Note that the free length we 

specify will have to bring the handle bar backward about 5-10 degrees (that is, negat ive 5-10 degrees 

a b o u t the X-axis). 



Delete the simulation result. 

F rom the browser, r ight click the Spring node and choose Add Translational Spring, the Insert 

Spring dialog box will appear (Figure 8-15). Pick the center hole of the upper bracket and the hook of the 

handle bar, as shown in Figure 8-16. Enter the followings: 

Stiffness: 30 

Length: 5 

Force: 0 

Coil Diameter: 1 

Number of coils: 10 

Wire Diameter: 0.25 

Note that the actual distance between the hole and the hook under the current configuration is about 

4.34 in., which can be obtained by clicking the Design box to the right of the Length field. The number 

we enter, 5, is larger than the actual distance. Again, the purpose of entering a larger free spring length is 

to make the handle bar lean backward at equilibrium. 

Click the Apply but ton to accept the spring. In the current configuration, the spring is compressed 

since the handle is leaning 10 degrees forward. 

Run a simulation. 

You should see that the handle bar start moving backward and the kicking rod moving forward due 

to the stretching of the spring. 

When the simulation is completed, the posit ion and velocity graphs of the kicking rod will appear, 

similar to Figures 8-17 and 8-18. Both the posit ion and velocity graphs reveal a sinusoidal type curve. 

This is due to the fact that no friction has been applied to the joints . Also, the handle bar is not colliding 

with the bracket. The graphs show that the per iod of one vibration is jus t under 0.5 seconds. 



N o w we will add a graph to show the rotation angle of the handle ba r . Delete the simulation result. 

F rom the browser, right click the handle-1 and choose Plot > Bryant Angles > Angle7; i.e., about the X-

axis. Rerun the simulation, the angle graph should appear, similar to Figure 8-19. The graph shows that 

the handle b a r is oscillating between 10 and -9 degrees. The angle of the handle b a r at equilibrium 

(assuming friction is added to dissipate energy) will be roughly the average of 10 and - 9 ; i.e., less than 1 

degree, which is far less than the desired angle (negative 5-10 degrees). 

Delete the simulation result, change the free length to 5.5 in., and rerun the simulation. The angle 

graph shown in Figure 8-20 indicates that the handle bar oscillates between 10 and -25 degrees, and the 

mean angle is about -7 degrees, which is desired. 

Note that a softer spring will increase the oscillation angle. If the spring constant is too small, say 2 

lbf/in, the handle bar m a y reach a dead lock posit ion wi th the middle pin of the kicking rod, similar to 

what was shown in Figure 8-4a, which is not desirable. On the other hand, if the spring is too stiff, the 



force required to push the handle bar forward m a y be excessive. Currently, the spring constant is set to 30 

lbf/in. This parameter will be revisited later in Task Three. Save you model before moving to Task Three. 

Task Three: Determining the Operating Force 

In Task Three, we will determine the operating force. The 

force must be small enough to al low children wi th limited 

physical strength to operate the mechanism. We will add a force 

at the handle, and use simulation results to determine the 

required operating force. 

The force to be determined is supposed to push the handle 

forward about 10 degrees, as shown in Figure 8-6, and then pull 

i t backward to push out the kicking rod. Then, we will turn on 

frict ion at both translational and revolute joints , and determine 

the operating force again. We will adjust the friction coefficient 

(assuming different physical conditions) in order to determine a 

range of the operating force. In the simulation, we will start wi th 

a configuration where the handle bar is set to -7 degrees; i.e., in 

its neutral position, as determined in Task Two. 

Save the model under a different name , say Task3. Delete 

the simulation result, and go back to SolidWorks assembly m o d e 

by clicking the Assembly buttons e % on top of the browser. 

First unsuppress the mate AngleL Then, right click the 

Anglel mate and choose Edit Feature. In the Anglel w indow 

(Figure 8-21), change the angle to 7, click the Flip direction 

button (to deselect it), and click the checkmark button on top to 

accept the definition. The handle bar should rotate to a 7-degree 

posit ion backward in the graphics screen, as shown in Figure 8-

22 . This is the initial configuration for Task Three simulations. 

Figure 8-21 

Next we will create a force at the handle. 

The force can be added from the browser 

by expanding the Forces branch, right clicking 

the Action Only node , and choosing Add 

Action-Only Force. In the Insert Action-Only 

Force dialog box, the Select Component to 

which Force is Applied field (see Figure 8-23) 

is active (highlighted in red) and ready for you 

to pick the entities. 

Rotate the mode l and pick the face of the 

handle, as shown in Figure 8-24. The part 

handle-1 is n o w listed in the Select 

Component to which Force is Applied field, 

and handle- 1/DDMFace 10 is listed in both the 

Select Location and the Select Direction fields. 

by clicking the Assembly buttons on top of the browser. 

First unsuppress the mate Anglel. Then, right click the 

Anglel mate and choose Edit Feature. In the Anglel w indow 

(Figure 8-21), change the angle to 7, click the Flip direction 

button (to deselect it), and click the checkmark button on top to 

accept the definition. The handle bar should rotate to a 7-degree 

posit ion backward in the graphics screen, as shown in Figure 8-

22 . This is the initial configuration for Task Three simulations. 



N o w the Select Reference Component to orient Force field is active for selection. We will click the 

ground button • to the right of the field. After that, you should see Assem5 (representing the ground) 

appear in the text field. A force symbol will appear in the graphics screen point ing downward, which is 

not what we want. We will have to change the force direction. 

Select all the text in the Select Direction field (press the let mouse button and drag to select all text), 

and press the Delete key to delete the current selection. Pick the end face of the foot, as shown in Figure 

8-24, to orient the force along the negative Z-direction. The arrow of the force symbol should n o w point 

to the negat ive Z-direction, which is normal to the face we picked. 

N o w the Select Reference Component to orient Force field is active for selection. We will click the 

ground button to the right 01 the held . Al ter that, you should see Assem5 (representing the ground) 

appear in the text field. A force symbol will appear in the graphics screen point ing downward, which is 

not what we want. We will have to change the force direction. 



Click the graph but ton (right most , as circled in 

Figure 8-25), the function graph will appear like the 

one in Figure 8-26. Note that internally 

COSMOSMotion will create a smooth spline 

function using the data entered. 

Close the graph and click Apply but ton to 

accept the force definition. 

Run a simulation. The result graphs will appear 

at the end of the 2-second simulation. 

The angle graph (Figure 8-27) shows that the 

handle bar starts a t an orientation angle of -7 

degrees as expected, and swing forward to a 13-

degree angle, which is desirable, due to the forward 

force. The handle then moves backward to about 26 

degrees, and then oscillates. 

The position graph in Figure 8-28 shows that the mass center of the kicking rod starts at about 24 in. 

It then travels to about 21.2 (backward) and then to about 26.8 in. forward due to the pull ing force and 

stretch of the spring. The overall distance that the kicking rod travels is about 5.6 in., which seems to be 

sufficient to produce enough m o m e n t u m to kick the ball. 

Figure 8-29 shows that the velocity of the kicking rod reaches about 27 in/sec when the rod is 

pushed near the foremost position. This velocity will produce a m o m e n t u m of about 310 lbf-sec at 0.5 

seconds, as shown in Figure 8-30. To create a momen tum graph you m a y simply right click kicking_rod-l 

from the browser and choose Plot > Translational Momentum > Z Component. Note that the velocity and 

m o m e n t u m are proportional, with the mass of the kicking rod as the scaling factor. 

The m a x i m u m force required to operate the device is determined to be 5 l b f (maximum force value 

entered), assuming no friction at any joints . Even though the force data we entered show a polyline in 

Figure 8-26, the actual force employed for simulation in COSMOSMotion is a spline curve generated 



Save you model . We will turn on friction and continue determining the required operating force. 

We will turn on friction at both the revolute and the translational joints . Friction for the 

CamMateTangent jo in t is currently unavailable in COSMOSMotion. 

Delete the simulation result from the browser. Expand the Constraints and then the Joints branch. 

Right click Revolute and choose Properties. In the Edit Mate-Defined Joint dialog box (Figure 8-33), 

choose the Friction tab, click the Use Friction, and choose Aluminum Greasy for both Material 1 and 

Material 2. The Coefficient (mu) will show 0.03. Enter Joint dimensions, Radius: 0.26 and Length: 0.31. 

Click Apply button to accept the definition. No te that the dimensions entered are the diameter of the pivot 

pin and the thickness of the handle bar where the jo in t is located. 



Similarly, turn on the friction for the translational joint . Enter 7.25, 7, and 7, for Length, Width, and 

Height, respectively, as shown in Figure 8-34. Note that the length dimension entered is the sum of both 

the lower brackets; i.e., 7 and 0.25 in. for the first and second lower brackets, respectively. The width and 

height of the inner square of the brackets is 7 and 7 in., respectively. 

Run a simulation and check the angle of the handle bar. 

Even though the friction coefficient is small (ju = 0.03) for both joints , the handle bar hardly moves . 

Therefore, the force magni tude must be increased. We will follow in general the overall force pattern, and 

increase the force magni tude to push the handle bar forward. 

Delete the simulation result. Expand the Forces and then the Action Only nodes from the browser. 

Right click the ForceAO node and choose Properties. In the Edit Action-Only Force dialog box, choose 

the Function tab (see Figure 8-25), and enter the followings: 



Click the graph button, the function will appear like the one in Figure 8-35. The m a x i m u m force is 

n o w 12 lbf. Note that the first half of the force (negative part) is increased more than twice, and the 

posit ive port ion remains the same. The posit ive part of the force is kept the same since the spring will 

contribute partially to the pull ing force. The overall force pattern is similar to that of Figure 8-26. The 

force data entered are results of a few trials-and-errors. 

The momen tum graph (Figure 8-37) shows that when the rod is pushed near the foremost posit ion 

the momen tum of the kicking rod is about 230 l b r s e c , which is less than the previous non-friction case. 

After reviewing the graphs, the 72- lb f force seems to be acceptable. However , this small operating force, 

12 lbf, is due to a very small friction force; i.e., friction coefficient jU = 0.03. This result also indicates that 

the spring constant 30 lbf/in seems to be adequate. Next , we will increase the friction coefficient by 

changing the material from Aluminum Greasy to Aluminum Dry. 

Delete the simulation result. Expand the Constraints and then the Joints branch. Right click Revolute 

and choose Properties. In the Edit Mate-Defined Joint dialog box, choose the Friction tab, and choose 

Aluminum Dry for both Material 1 and Material 2. The Coefficient (mu) will show 0.20. Repeat the same 

for the translational joint . Run a simulation. The handle bar is hardly moved. That is, the force will have 

to be increased again. 

Delete the simulation results. Right click the ForceAO node to enter the force data. Note that after 

several attempts, a force that is large enough to m o v e the handle bar, therefore the kicking rod, is about 

65 lbf. More specifically, the force data entered are: 



Click the graph button, the function will appear like the one in Figure 8-38. Even though the 

max imum pushing force is n o w 65 lb f . the pull ing force (positive portion) remains the same, A r e : 

running a simulation, the angle and m o m e n t u m graphs appear as in Figures 8-39 and 8-40, respectively 

Both seem to be reasonable. However , the large operating force, 65 lb f , raises a flag. The mechanism 

requires too large a force for a child to operate. 

Note that the simulation engine, ADAMS/Solver, is very sensitive to the force data entered. You may 

encounter problems while carrying out some of the simulations in Task Three. W h e n this happens, simply 

change the m a x i m u m force data, e.g., 65, to a slightly different value, e.g., 63, until a simulation can be 

completed. 

Save your model . 



8.4 Result Discussion 

Apparently, the biggest concern raised in the simulations is the large operating force. The friction 

coefficient ju = 0.20, provided by COSMOSMotion for Aluminum-Aluminum contact without lubrication, 

seems to be physically reasonable. Al though this friction coefficient represents an extreme case since in 

reality some lubricant would be added to the joints to reduce friction resistance. Nevertheless, the force is 

still too large. As revealed in simulations; i.e., Task Three, the m a x i m u m operating force increases from 5 

lbf for non-friction, 12 lbf for small friction (ju = 0.03) to 65 lbf for large friction (ju = 0.20). Reducing the 

fr ict ion force at jo ints , especially the translational jo in t be tween the kicking rod and the two lower 

brackets on the plate, is critical for a successful device. Y o u can easily confirm that the translational jo in t 

contributes significantly to the friction encountered in the mechanism by conducting separate simulations 

where friction is only present in one of the two joints . 

The flag raised by the simulation has been observed in the physical device, as shown in Figure 8-41, 

built by students following the design created in SolidWorks and COSMOSMotion. The physical device 

confirms that the contact be tween the kicking rod and the two brackets produces a large friction force, 

resulting in a large operating force to operate the device. For children with limited physical strength, such 

a device is unattractive. 

In order to reduce the friction, four bearings are added to the device, as shown in Figure 8-42. Two 

are added to the top surface of the kicking rod, and two are underneath the kicking rod. With the bearings, 

the friction is significantly reduced. Therefore, a smaller force is required to operate the device. The 

actual operating force is less than 20 lbf. 

8.5 Comments on COSMOSMotion Capabilit ies and Limitations 

Using COSMOSMotion does answer critical questions and help the design process, as demonstrated 

in this example. However , from this example , a number of limitations in COSMOSMotion have also been 

encountered. Knowing these limitations will help you use COSMOSMotion more effectively. 

First, the simulation engine, ADAMS/Solver, which solves the equations of mot ion for the 

mechanism, is not stable. Sometimes when you rerun the same simulation, you could see slightly different 

results. This problem is more vivid when we ran the same simulation using different computers . 



Moreover, the simulation engine produced results, such as the velocity or m o m e n t u m (see Figures 8-37 

and 8-40), with spikes, which is not quite realistic. Some of the spikes disappear or become smaller when 

we rerun the same simulation. 

Second, friction is not supported for a CamMateTangent joint . Therefore, an attempt was made to 

add a 3D contact jo in t be tween the middle pin and the slot of the handle bar. A number of restitution 

coefficients were used, including 0.5, 0.75, etc. Yet, adding a 3D contact jo in t significantly slow down the 

motion of the handle bar and the kicking rod since lots of contact are encountered be tween the outer 

surface of the middle pin and the inner surface of the slot when the mechanism is in motion. More contact 

causes more energy dissipation. However , the s low-down is way too much to grant a physically 

reasonable simulation. In addition, more spikes appear in graphs, such as in velocity. However , the 

biggest issue with adding the 3D contact is that the simulation engine becomes extremely sensitive to the 

initial orientation angle of the handle bar and the magni tude of the operating force. For some simulations, 

the solution engine encountered problems, for example, force imbalance at certain t ime steps during the 

simulation, and terminated the simulation prematurely. 

Overall COSMOSMotion is an excellent tool with lots of nice features and capabilities for support of 

mechanism design and analysis. However , as ment ioned in this book numerous t imes, no software is 

foolproof. Before creating a simulation model , you always want to formulate your design questions and 

set up your simulation model and scenarios gearing toward answering these specific questions. You will 

have to exam the simulation results very carefully and challenge yourself about the validity of the results 

since if you don ' t somebody else will do, usually in a less friendly way. 





The calculated degrees of f reedom result i s - 4 , which include f ive redundant d o f s . 

Redundancy 

Redundancies are excessive d o f s . When a jo int constrains the model in exactly the same w a y as 

another jo in t (like the door example) , the model contains excessive d o f s , also known as redundancies . A 

joint becomes excessive w h e n it does not introduce any further restriction on a body's motion. 

I t is important that you eliminate redundancies from your mot ion model while carrying out dynamic 

analyses. I f you do not remove redundancies , you m a y not get accurate values when you check joint 

reactions or load reactions. 

For example, if you model a door using two revolute jo ints for the hinges, the second revolute jo in t 

does not contribute to constraining the door's motion. COSMOSMotion detects the redundancies and 

ignores one of the resolute jo ints in its analysis. The outcome m a y be incorrect in reaction results, yet the 

APPENDIX A: DEFINING JOINTS 

Degrees of Freedom 

Understanding degrees of freedom is critical in creating successful motion model. The free degrees 

of freedom of the mechan ism represent the number of independent parameters required to specify the 

position, velocity, and acceleration of each rigid body in the system for any given t ime. A completely 

unconstrained body in space has six degrees of freedom, three translational and three rotational. If you 

add a joint ; e.g., a revolute jo in t to the body, you restrict its movement to rotation about an axis, and the 

free degrees of freedom of the body are reduced from six to one. 

For a given mot ion model , you can determine its number of degrees of freedom using the Gruebler ' s 

count. The mechanism's Gruebler count is calculated using the mechanism's total number of bodies . As 

ment ioned above, each movable body introduces six degrees of freedom. Joints added to the mechanism 

constrain the system, or remove d o f s . Mot ion inputs, i.e., mot ion drivers, remove additional d o f s . 

COSMOSMotion uses the following equation to calculate the Gruebler ' s count: 

where D is the Gruebler count representing the total free degrees of freedom of the mechanism, M is the 
number of bodies excluding the ground body, TV is the number of d o f s restricted by all joints , and O is the 
number of the mot ion inputs in the system. 

For kinematic analysis, the Gruebler ' s count must be equal to or less than 0. The ADAMS/Solver 

recognizes and deactivates redundant constraints during motion simulation. For a kinematic analysis, if 

you create a model wi th a Gruebler ' s count greater than 0 and try to simulate it, the simulation will not 

run and an error message will appear. 

If the Gruebler ' s count is less than zero, the solver will automatically remove redundancies, if 

possible. For example, you m a y apply this formula to a door model that is supported by two hinges 

modeled as revolute joints . Since a revolute jo in t removes f ive d o f s , the Gruebler ' s count becomes: 

(A.1) 



motion is correct. For complete and accurate reaction forces, i t is critical that you eliminate redundancies 
f rom your mechanism. 

For a kinematic simulation where you are interested in displacement, velocity, and acceleration, 

redundancies in your model do not alter the performance of the mechanism. 

Y o u can eliminate or reduce the 

redundancies in your model by carefully 

choosing joints . These joints must be able to 

restrict the same d o f s , but not duplicate each 

other, introducing redundancies. After you 

decide which joints you want to use, you can 

use the Gruebler ' s count to calculate the d o f s 

and check redundancies. 

Before you select a jo in t to add to your model , you should know what movement you want to 

restrain for the body and what movement you want to allow. The following table describes the commonly 

employed joint types in COSMOSMotion and the degrees of freedom they remove. 

bring up the dialog box, as shown in Figure A-

1. Note that the DOF field in the dialog box 

will show the Gruebler ' s count if a simulation 

has been completed. If not, You may click the 

Calculate button to ask COSMOSMotion to 

calculate the actual dof. In the message 

window appearing next (Figure A-2) , 

COSMOSMotion identifies redundant d o f s 

and recalculates the dof for the simulation 

model . 

Y o u m a y also ask COSMOSMotion to 

calculate the Gruebler ' s count for you. You 

can simply click the Show simulation control 

button on top of the graphics screen to 



The following provides more details about the joints listed in the table above. 

Revolute Joint 

A revolute joint , as depicted in Figure A - 3 , al lows the rotation of one rigid body wi th respect to 

another r igid body about a common axis. The origin of the revolute jo in t can be located anywhere along 

the axis about which the bodies can rotate with respect to each other. The jo int origin is assigned by 

COSMOSMotion when you enter COSMOSMotion from SolidWorks. 

Orientation of the revolute jo in t defines the direction of the axis about which the bodies can rotate 

with respect to each other. The rotational axis of the revolute jo in t is parallel to the orientation vector and 

passes through the origin. 

Translational Joint 

A translational jo in t allows one rigid body to translate along a vector with respect to a second rigid 

body, as illustrated in Figure A-4. The rigid bodies m a y only translate, not rotate, wi th respect to each 

other. 

The location of the origin of a translational jo in t with respect to its r igid bodies does not affect the 

mot ion of the jo in t but does affect the reaction loads on the joint . The location of the jo in t origin 

determines where the joint symbol is located. 

The orientation of the translational jo in t determines the direction of the axis along which the bodies 

can slide with respect to each other (axis of translation). The direction of the mot ion of the translational 

jo in t is parallel to the orientation vector and passes through the origin. 

Cylindrical Joint 

A cylindrical jo in t allows both relative rotation and relative translation of one body with respect to 

another body, as shown in Figure A-5 . The origin of the cylindrical jo in t can be located anywhere along 

the axis about which the bodies rotate or slide with respect to each other. 

Orientation of the cylindrical jo in t defines the direction of the axis about which the bodies rotate or 

slide along with respect to each other. The rotational/translational axis of the cylindrical jo in t is parallel to 

the orientation vector and passes through the origin. 



Spherical Joint 

A universal jo int allows the rotation of one body to be transferred to the rotation of another body, as 

shown in Figure A-7. This jo in t is particularly useful to transfer rotational mot ion around corners, or to 

transfer rotational mot ion between two connected shafts that are permit ted to bend at the connection point 

(such as the drive shaft on an automobile) . 

The origin location of the universal jo in t represents the connection point of the two bodies. The two 

shaft axes identify the center lines of the two bodies connected by the universal joint . Note that 

COSMOSMotion uses rotational axes parallel to the rotational axes you identify but passing through the 

origin of the universal joint . 

A screw jo in t removes one degree of freedom. It constrains one body to rotate as it translates wi th 

respect to another body, as shown in Figure A-8 . 

W h e n defining a screw joint , you can define the pitch. The pitch is the amount of translational 

displacement of the two bodies for each full rotation of the first body. The displacement of the first body 

A spherical jo in t allows free rotation about a common point of one body with respect to another 

body, as depicted in Figure A-6 . The origin location of the spherical jo in t determines the point about 

which the bodies pivot freely with respect to each other. 



relative to the second body is a function of the b o d y ' s rotation about the axis of rotation. For every full 

rotation, the displacement of the first body along the translation axis with respect to the second body is 

equal to the value of the pitch. 

Very often, the screw joint is used with a cylindrical joint . The cylindrical jo in t removes two 

translational and two rotational degrees of freedom. The screw joint removes one more degree of freedom 

by constraining the translational mot ion to be proportional to the rotational motion. 

Planar Joint 

A planar jo in t al lows a plane on one body to slide and rotate in the plane of another body, as shown 

in Figure A-9. 

The orientation vector of the planar jo in t is perpendicular to the jo in t ' s plane of motion. The 

rotational axis of the planar joint , which is normal to the jo in t ' s plane of motion, is parallel to the 

orientation vector. 

Figure A-9 Planar Joint Symbol Figure A-10 Fixed Joint Symbol 

Fixed Joint 

A fixed jo int locks two bodies together so they cannot move wi th respect to each other. The fixed 
jo int symbol is shown in Figure A-10. 



M a p p e d SolidWorks Mates 

After you bring an assembly from SolidWorks to COSMOSMotion and assign components to ground 

part and moving parts, COSMOSMotion automatically maps assembly mates to joints . In most cases, 

these joints work well for the mot ion simulation. A selected set of the mapped SolidWorks mates , which 

is commonly employed in assembly, is given in the next table for your reference. 





Therefore, from Eqs. B.2 and B .3 , we have 7 l b f = 386 l b m in / sec 2 , and the force in l b m i n / sec 2 unit 

is 386 t imes smaller than that of l b f that we are more used to. When you apply a 7 l b f force to the same 

mass block, it will accelerate 386 in / sec 2 , as shown in Figure B - l b . 

On the other hand, we have the mass unit, 7 l b m 1/386 l b f sec 2 / in . I t means that a 1 l b m mass b lock 

is 386 t imes smaller than that of a 7 l b f sec 2 / in block. Therefore, a 1 l b f sec 2 / in b lock will weigh 386 l b f 

on earth. W h e n applying a 1 lbf force to the mass block, it will accelerate at a 7 in / sec 2 rate, as illustrated 

in Figure B - l c . 



APPENDIX C: IMPORTING Pro/ENGINEER PARTS AND 
ASSEMBLIES 

From t ime to t ime when you use COSMOSMotion for simulations, you may encounter the need for 

importing solid models from other C A D software, such as Pro/ENGINEER. SolidWorks provides an 

excellent capability that support import ing solid models from a broad range of software and formats, 

including Parasolid, ACIS , IGES (Initial Graphics Exchange Standards), STEP (STandard for Exchange 

of Product data), SolidEdge, Pro/ENGINEER, etc. For a complete list of supported software and formats 

in SolidWorks, please refer to Figure C-1 . You may access this list by choosing File > Open from the 

pul l -down menu, and pull down the Files of type in the File Open dialog box. 

In this appendix, we will focus on 

importing Pro/ENGINEER parts and 

assemblies. Hopefully, methods and 

principles you learn from this appendix 

will be applicable to import ing solid 

models from other software and formats. 

SolidWorks provides capabilities 

for importing both part and assembly. 

Users can choose two options in 

importing solid model . They are Option 

1: import ing solid features and Option 2: 

importing jus t geometry. Import ing solid 

features m a y bring you a parametric 

solid model that jus t like a SolidWorks 

part that you will be able to modify. On 

the other hand, if you choose to import 

geometry only, you will end up with an 

imported feature that you cannot change 

since all solid features are lumped into a 

single imported geometry without any 

solid features nor dimensions. 

Import ing geometry is relatively straightforward. In general, SolidWorks does a good j o b in bringing 

in Pro/ENGINEER part as a single imported geometry. In fact, several other translators, such as IGES and 

STEP, support such geometric translations well . IGES and STEP are especially useful when there is no 

direct translation from one C A D to another. 

Import ing solid models wi th solid features is a lot more challenging, in which solid features 

embedded in the part geometry, such as holes, chamfers, etc., mus t be identified first. In addition, 

sketches that were employed for generating the solid features must be recovered and the feature types, for 

instance revolve, extrude, sweep, etc., mus t be identified. With virtually infinite number of possibilities in 

creating solid features, it is almost certain that you will encounter problems while importing solid models 

with feature conversion. Therefore, if you do not anticipate making design changes in SolidWorks. it is 

highly recommend that you import parts as a single geometric feature. 

We will discuss the approaches of importing parts, and then import ing assemblies. In each case, e 

will try both options; i.e., import ing solid features vs . importing geometry. We will use the gear train 

example employed in Lesson 6 as the test case and as an example for illustrations. 





sketches in the graphics screen by clicking their names listed in the browser. In addition, the back plate 
(Extrudel in the browser) is recognized incorrectly. Certainly, SolidWorks is capable of importing some 
parts correctly and completely, especially, when the solid features are relatively simple (but not this gear 
housing part). 

If you take a closer look at any of the 

successful solid features, for example 

ExtrudeS, you will see that the sketches 

(for example Sketch3 of ExtrudeS) of the 

solid features do not have complete 

dimensions. Usual ly a (—) symbol is 

placed in front of the sketch, indicating 

that the sketch is not fully defined. 

Apparently, this translation is not 

satisfactory. Unfortunately, this translation 

represents a typical scenario you will 

encounter for the majority of the parts. In 

many cases, it m a y take only a small effort 

to repair or re-create wrong or 

unrecognized solid features. However , 

when you translate an assembly with 

many parts, the effort could be substantial. 

Option 2: Importing Geometry 

Import ing geometry is more straightforward and has a higher successful rate than that of importing 

solid features. 

Repeat the same steps to open the gear housing part, gboxjiousingprt. In the Pro/ENGINEER to 

SolidWorks Converter dialog box (Figure C-8), choose Import geometry directly (default), and then 

Kniting (default) in order to import solid models instead of jus t surface models . No te that if you choose 

BREP (Boundary Representation), only boundary surfaces will be imported. Click OK. 



The conversion process will start. After about a minute or two, the converted model will appear in 

the graphics screen, as shown in Figure C-9. In addition, an entity Importedl will appear in the browser 

(Figure C-9). As ment ioned earlier, there will be no parametric solid feature with dimensions and sketch 

converted if you choose Option 2. However , the geometry converted seems to be accurate. All the 

geometric features in Pro/ENGINEER shown in Figure C-3 were included in this imported feature. This 

translation is successful. Since we do not anticipate making any change to the gear housing, this imported 

part is satisfactory. The gear housing part, gbox housing, sldprt, employed in Lesson 6 was created by 

using Option 2. 

We will import the input gear assembly (gbox_input.asm) shown in Figure C-10 using both options. 

We will try Option 1 first; i.e.. importing solid features. As shown in Figure C-10 {Pro/ENGINEER 

Model Tree window) , there are 11 parts (and several da tum features) in this assembly. SolidWorks will try 

to import this assembly as well as the 11 parts from Pro/ENGINEER. 



Import ing geometry is also more straightforward for assembly and has a higher rate of success. 

Repeat the same steps to open the input gear assembly, gbox input.asm. In the Pro/ENGINEER to 

SolidWorks Converter dialog box (Figure C- l 3), choose Use body import for all parts (default), and then 

Kniting (default) in order to import solid models . Choose Overwrite for If same name SolidWorks file is 

found, and choose Import material properties and Import sketch/curve entities. Click Import. The 

conversion process will begin. 

After about a minute or two, the converted assembly will appear in the graphics screen, as shown in 

Figure C - l 4 . The assembly and all 11 parts seem to be correctly imported. If you expand any of the part 

branch, for example, the gear (wheel_gbox_pinion_ls<l>), you will see an imported feature listed, as 



depicted in Figure C-14. Again, there is no solid feature converted in any of the parts. In addition, the 
Mates branch is empty. 

Since we do not anticipate making any change to this input gear assembly, this imported assembly is 

satisfactory, except it does not have any assembly mates. Assemble all 11 parts (may be more for some 

cases) will take a non-trivial effort. Since we do not anticipate making change in how these parts are 

assembled, we will merge all 11 parts into a single part. 

In SolidWorks, you can jo in two or more parts to create a new part in an assembly. The merge 

operation removes surfaces that intrude into each other's space, and merges the parts into a single solid 

volume. We will insert a n e w part into the assembly and merge all 11 parts into that new part. 

Choose from the pul l -down menu Insert > 

Component > New Part. In the Save As dialog 

box, enter gbox Jnput for part name , and click 

Save. SolidWorks is expecting you to select a 

plane or a flat face to place a sketch for the new 

part. Click a plane or planar face on a component , 

for example pick the assembly Front p lane from 

the browser, the Front plane will appear in the 

graphics screen (Figure C-15). The new part 

gboxinput<l> will appear in the browser. In the 

new part, a sketch opens on the selected plane. 

Close the sketch. Because we are creating a jo ined 

part, we do not need a sketch. 

Next , we will select all 11 parts and merge 

them into the new part. 

F rom the browser, click the first part wheel box_shaftinput<l>, press the Shift key, and then click 
the last part, screw_setjip_6*6<2>. All 11 parts will be selected. 

F rom the pul l -down menu, choose Insert > Features > Join. The Join w indow will appear 

(overlapping with the browser) as shown in Figure C-16. In the Join window, all 11 parts are listed. All 

you have to do is to click the checkmark on top to accept the parts. Save the assembly (and the part), and 

then close the whole assembly. 

N o w open the part gbox Jnput. Make sure you open gbox input, sldprt instead of gboxJnput. sldasm. 

The part gbox input will appear in the graphics screen. In addition, all entities belong to this part will be 

listed in the browser, as shown in Figure C-17. Note that there is an arrow symbol -> to the right of the 

root entity, gbox Jnput. This symbol indicates that these entities enclosed in this part refer to other parts 

or assembly. Note that the Joinl branch has the same symbol. Expand the Joinl branch, you will see 11 

parts listed, all with arrows, pointing to the actual parts currently in the same folder. When the link is 

broken; i.e., when the referring parts are removed from the folder, a question mark symbol will be added 

to the arrow. 

The three gear parts, gbox Jnput. sldprt, gboxjniddle.sldprt, and gbox output, sldprt, employed for 

Lesson 6 were created following the approach discussed. One axis in each part that passes through the 

center hole of the gear was created simply by intersecting two planes, for example , Top and Right planes 

for the axis in gbox Jnput. sldprt, as shown in Figure C-18. These axes are necessary for creating gear 

pairs, as discussed in Lesson 6. 






